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Chapter 1 - Introduction
Copyright
©2012-2017 Brompton Technology Ltd. All rights reserved.

Trademarks
Brompton is a registered trademark owned by Carallon Ltd.
All other brand and product names used in this document may be trademarks, registered
trademarks, trade names of their respective holders.

Changes
The information and specifications contained within this document are subject to change
without notice. Brompton Technology Ltd reserves the right to make improvements and
changes to the hardware and software described in this document at any time and without
notice.
Brompton Technology Ltd assumes no responsibility or liability for any errors or inaccuracies
that might occur in this document.

About This Manual
This manual provides all the information required for the correct and safe use of the Tessera
processors and the supplied software.
This revision of the manual was written for Tessera software version: v1.4 published on: 21
December 2017

About the Tessera System
The Tessera system comprises processors, receiving cards and software. These elements can
be used with a wide range of LED fixtures including panels, battens and mesh. Brompton
Technology welcomes all owners and manufacturers who wish to use Brompton processing
to control their LED video products.
For more information on becoming a Brompton partner please contact
info@bromptontech.com.
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Handling and Safe Operation
The Tessera M2 processor is packaged in a rugged custom-designed 2U 19" rackmounting
case with integral mounting handles.
Despite the strength of this case the processor should at all times be adequately supported
in a rack. The weight of the processor should never be supported entirely on the rack ears as
this can lead to distortion especially if the rack is roughly handled.
There are no user serviceable parts inside the unit and opening it will expose the user to
potentially dangerous voltages. The unit should never be operated with the cover exposed.
Opening the unit will invalidate the warranty.
The product is designed to operate from a grounded power source between 100 and 250V
AC, 47 -63Hz . Care should be taken to make sure this is a stable power source and if surges
are possible a wise precaution may be to place the unit on an uninterruptible power supply
(UPS).
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Chapter 2 - General Overview
General
Brompton Technology make three Tessera LED video processors for different applications:
M2, T1 and S4.
The M2 is the flagship in the Tessera range of processors. It can control a nominal 2 million
pixels over four Gigabit outputs and can accept incoming signals in a wide variety of formats
up to and including 3G-SDI and up to 1080p60.
The T1 has the front-side processing, scaling, rotation and DMX control of the M2 processor
but with a single Gigabit output and can control a nominal 0.5 million pixels.
Meanwhile, the S4 processor does not have the front-side processing, scaling, rotation of
the T1 and the M2, but can control the same number of pixels across four Gigabit outputs as
the M2.

System Overview
The M2 processor can receive video input signals on any one of up to 3 ports:
l

SDI A

l

SDI B

l

DVI-I/ Analog

The T1 and S4 processors only support DVI-D.
These inputs are dealt with in more detail in "Input Properties" on page 64.
The Tessera processors can be controlled either via a mouse and keyboard or via a Mac or PC
running the Tessera Remote software and connected via Gigabit Ethernet. The processors
have an integral DisplayPort (DP++) output port for local control and monitoring, and
connects to fixtures via up to four Gigabit Ethernet outputs (supplied on etherCON™
connectors). Each Gigabit output can be distributed via standard Gigabit Ethernet
peripherals such as switches and fibre optic transceivers.
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System setup diagram

Figure 2-1. Typical system set-up
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M2
Front Panel

A
B

Front Panel Status LEDs
2 x USB2.0 type A ports, which allow for the connection of USB memory storage
devices, peripherals such as keyboard or mouse or other USB devices

Front Panel Status LEDs
LED Name
Active
Ethernet
DMX In
Video In
Reference In
Tessera Out
Black/Freeze
Overtemp

Indication
Is lit whilst Local User Interface or Tessera Remote in use
When blinking indicates that the processor is detecting a network
connection.
A DMX signal is being received by the processor
The processor is connected to a valid video input source.
The processor has a valid source of genlock connected to the reference input connector.
The processor is connected to panels.
Either the blackout or freeze button has been enabled.
Off: temperature normal
Blinking: processor overheating but operational
On: processor overheated and shutdown
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Rear Panel Connections

Figure 2-2. M2 processor

Figure 2-3. M2B processor
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Remote Control
A

Connect a PC or Mac running the Tessera Remote or Tessera Control
application, or an eDMX protocol directly to the local data Gigabit Ethernet port.
Local User Interface

B

The M2 Processor can be operated locally with a monitor connected via
DisplayPort. Peripherals such as mouse and keyboard can be connected to the
USB ports on either the front or rear panel.
DVI Input

C

A DVI input of up to 1920x1080 @ 60Hz (148.5MHz pixel clock) is available. This
is a DVI-I input which supports DVI-D, VGA/ RGBHV and Component Analog
(YPbPr) with a suitable adapter.

D
E

F

G
H

I

Reference Input
Used for analog bi-level or tri-level sync.
DMX 512-A Input
For DMX real-time control.
3G-SDI Input
Two 3G-SDI inputs are available. Both inputs can be used concurrently. The SDI
inputs support up to 3G-SDI level A or level B. Both inputs can be used together
to support Dual Link HD-SDI.
Loop Thru Ports
All video inputs and syncs have re-clocked loop thru ports.
DisplayPort Input
Not currently implemented.
Gigabit Ethernet Outputs
The M2 processor has four Ethernet outputs which are provided on EtherCON
connectors. Fixtures should be connected with gigabit Ethernet cable (Cat-5e or
above). For more information on Ethernet connection see "Connecting
Fixtures" on page 25.
On/Off Switch

J

K

The processor can be turned off from the power switch. It can be shutdown
from the local interface or remote computer. No harm will result from turning
the processor off at the switch.
IEC Mains Input
The input is auto ranging from 100-250v/47-63Hz
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L

M

DMX512-A Input and Thru
For DMX real-time control
Remote Control Ports
The M2B has two Gigabit Ethernet ports for Remote Control. These act like a
switch and can be used for daisy-chaining in to other Tessera processors.
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S4
Front Panel

A
B
C
D

Front panel status LEDs
Black Button: sends the output of the processor to black
Freeze button: freezes the output of the processor
2 x USB 2.0 type A ports, for the connection of USB memory storage devices, peripherals such as a keyboard or mouse or other USB peripherals

Front Panel Status LEDs
LED
Name
Active
Ethernet
Video In
Tessera
Out

Indication
Blinks whilst Local User Interface or Tessera Remote application in use
Processor is connected to Tessera Remote. When blinking indicates that
the processor is detecting a network connection.
The processor is connected to a valid video input source.
The processor is connected to panels.
Off: Temperature normal

Overtemp

Blinking: processor overheating but operational
On: processor overheated but shutdown
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Rear Panel

Gigabit Ethernet Outputs
A

B

The S4 processor has four Ethernet outputs which are provided on EtherCON
connectors. Fixtures should be connected with gigabit Ethernet cable (Cat-5e or
above). For more information on Ethernet connection see Connecting Fixtures
on page 1.
DVI-D Input
A DVI-D input of up to 1920x1080 is available, with a reclocked DVI-D thru
Local User Interface

C

The M2 Processor can be operated locally with a monitor connected via
DisplayPort. Peripherals such as mouse and keyboard can be connected to the
USB ports on either the front or rear panel
Remote Control Ports

D

The S4 has a Gigabit Ethernet port for remote control with Tessera Remote
software only.
IEC Mains Input and On/Off Switch

E

The S4 processor supports a voltage range of 100V-240V, and a mains frequency
range of 50 - 60Hz. The processor can be turned off from the power switch. It can
be shutdown from the local interface or remote computer. No harm will result
from turning the processor off at the switch.
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T1
Front Panel

A
B

Front panel status LEDs
2 x USB 2.0 type A ports, for the connection of USB memory storage devices, peripherals such as a keyboard board or a mouse or other USB peripherals

Front Panel Status LEDs
LED Name
Active
Ethernet
DMX In
Video In

Indication
Blinks whilst Local User Interface or Remote Control in use
Processor is connected to Tessera Remote. When blinking indicates
that the processor is detecting a network connection.
A DMX source is connected to the processor.
The processor is connected to a valid video input source.

Tessera Out
Black/Freeze

The processor is connected to panels.
Either the blackout or freeze button has been enabled.
Off: temperature normal

Overtemp

Blinking: processor overheating but operational
On: processor overheated and shutdown
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Chapter 3 - Quick Start Guide
To get a basic system up and running, just follow these steps. This guide covers starting a
new project with fixtures connected. To set up a project offline and connect fixtures at a
later stage, see "Tessera Remote and Offline Editor" on page 30. Further information on all
the features contained in this Quick Start Guide can be found in the relevant sections of the
manual.

Setting up your system

Figure 3-1. The Rear Panel

1. Connect your fixtures to the Ethernet output ports, using Gigabit Ethernet cable
(Cat 5e or above) and network switches, if necessary, using Ethernet connection
rules.
2. Connect your video input source(s) to the DVI and/or SDI input ports.
3. Connect a monitor to the Local UI DisplayPort connector. If you are using DVI, HDMI
or VGA with the monitor then you will need to use the relevant DisplayPort
adaptor. Connect a keyboard and mouse to the USB ports. Alternatively, you can
access the processor's user interface through a Mac or Windows PC running the
Tessera Remote application.
4. Connect the IEC mains input and switch the processor on. When the processor has
powered up, the monitor will display the Start Screen. The processor may be configured to auto-load a previous project, which it will do after a set amount of time,
by default 10s, if the user does not invervene. If a previous project auto-loads it is
necessary to close the project to return to the Start Screen.
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Figure 3-2. The Start Screen

Setting up your project
5. From the Start Screen, select New… The New Project Wizard will launch.

Figure 3-3. The New Project Wizard
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6. Type in a name for your project. If you are using Tessera Remote in offline mode,
you can also select the location in which it is to be saved (if you are accessing the
processor directly, the project will be saved to its internal storage).
7. Select the fixture type from the dropdown menu and uncheck the Create an array
of panels box. If you are using more than one fixture type, click the Go To
Advanced View button. Select the fixtures required. You can hold CTRL whilst
selecting to select multiple fixtures.
8. Click Create. You will now be taken to the Main Project Screen.

Figure 3-4. Main Project Screen
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Connecting your fixtures

Figure 3-5. Add fixture from network button

Click the Add Fixtures From Network button. The Add Fixtures From Network toolbar will be
displayed.

Figure 3-6. The Add Fixtures From Network toolbar.

1. The processor will show any attached strings of fixtures and the number of fixtures
on each string. In the picture above, the processor can see fixtures connected to
outputs 1, 2 and 3. Outputs 1 and 2 have a single string of 9 fixtures on each output,
whilst Output 3 has 4 strings with 12, 18, 24, and 12 fixtures.
2. Click on the string of fixtures you wish to add. The first fixture in the string will be
highlighted white, while the other fixtures will display varying shades of the same
colour to denote the the order of the fixtures in the string from dimmest to brightest.
3. Click on the canvas to add the first fixture in the string, then add subsequent fixtures in the string using the same method.
4. Repeat the process for all strings, then click the green Back arrow to return to the
Main Project Screen. The connected fixtures will start to output video and the fixtures on the canvas will display a green circle to indicate they are online.

- 23 -

Figure 3-7. A highlighted Recoloured string
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Chapter 4 - Connecting Fixtures
Tessera processors can drive any Tessera compatible LED panel, mesh or batten system.
Most panel products will have a receiver card fitted inside each cabinet or tile. In the case of
ray or batten type products where there is a low pixel count per fixture, the panel controller
card may be housed in a buffer box and a number of fixtures connected to each buffer.
All Tessera compatible LED fixtures have two Gigabit Ethernet ports: one to allow
connection from the processor and one to connect to the next unit in the chain. These ports
can be used interchangeably.
The processor communicates with LED fixtures on the network using the Tessera protocol,
which is transmitted via cabling that conforms to Cat 5e or above (this includes Neutrik
etherCON terminations).
The topology of a Tessera system is very simple. The fixtures just need to be connected to
the processor either directly or via a Gigabit Ethernet network switch. Once connected, a
group of fixtures in a daisy-chain becomes a string.

Note - The Tessera Protocol only supports Gigabit Ethernet compliant
equipment. It will not work at all with 100BASE-T (Fast Ethernet) or
10BASE-T

Connection Guidelines
Cat 5e or better cable must be used to connect between processors and fixtures. The
maximum supported individual cable length is 100m. The Tessera protocol can be
transmitted over standard Gigabit Ethernet compliant fibre optic hardware for single runs
exceeding this distance.
The suggested maximum number of nodes between the processor and the furthest fixture
in any system is 5 switches and 50 fixtures (fibre optic transceivers would also count as
switches). By using switches up to 500 fixtures can be run from a single processor output
port (assuming this does not exceed the pixel limit of the output).
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Note - The Tessera Protocol does not support connection over WiFi

Redundant Cabling
Redundant cabling is supported on Tessera M2 and S4 processors, where two outputs can
be configured to operate as a redundant pair. Redundancy is not supported on Tessera T1
processors as they only feature a single output. The first output acts as the primary port,
while the second output acts as the backup. A cabling loop can now be created from the
primary port, through a string of panels, and then back to the processor. In the case of
signal loss or errors with the primary feed, the panels will automatically switch to the backup
feed, thus ensuring that video continues to be displayed despite a cable failure anywhere
within the loop.

Figure 4-1. Two redundant pairs of outputs from an processor to
two chains of panels.

Redundancy can be independently enabled for each pair of output ports by enabling the tickbox on the System tab. Once enabled, the processor will indicate 'Loop OK' if the two ports
are correctly cabled together in a loop with no breaks.

- 26 -

Figure 4-2. Redundancy options on the System tab, including the
loop status indicator and a double-height load bar for a redundant
output pair on ports 1 and 2. Ports 3 and 4 continue to operate
independently without redundancy.

When operating in redundant mode:
l
l

l
l

l

l

l

l

l

The processor and all panels must be running firmware V1.4.0 or later.
Panels must be cabled in a single chain of up to 50 panels, with each end of the chain
connected back to the processor. Ethernet switches must not be used to 'split' the
signal. Other Ethernet hardware (such as fibre extenders) is supported as normal.
Redundancy should be enabled on the processor before cabling up panels in a loop.
The same capacity limits (described in "Output Capacity" on the next page) that normally apply to a single port will apply to the pair of ports. This effectively halves the
overall processor capacity, as each output signal is being 'doubled up'.
The processor load bars for the two ports will combine into a single bar indicating the
load for that pair.
Switching between redundant mode and normal mode will temporarily black-out the
video signal for all connected panels on all ports, so should not typically be performed 'live'.
The active feed (primary or backup) currently used by each panel can be viewed in the
Online Panels screen.
If both the primary and backup signals are operational, each panel may choose to use
either signal. If a panel receives a video error on the currently active port, it will switch
to the other port for the next frame. In the case of complete signal loss on one port,
the panel will switch to the other port within a few frames.
Each loop must be cabled between the two adjacent ports on the same processor.
(I.e. Port 1 to Port 2, and Port 3 to Port 4.)
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Output Capacity
The capacity of a Tessera output port depends primarily on the network bit depth and the
genlocked frame rate. The nominal pixel capacity is outlined in the table below:
Refresh/ Bit Depth
24 Hz
25 Hz
30 Hz
50Hz
60Hz

8 bit
1,312,500
1,260,000
1,050,000
630,000
525,000

10 bit
1,050,000
1,008,000
840,000
504,000
420,000

12 bit
875,000
840,000
700,000
420,000
350,000

Other factors affecting output capacity
Fixture rotation
Rotating fixtures on-axis (i.e. by 0°, 90°, 180° or 270°) has no affect on the output capacity.
However each fixture rotated off-axis is counted twice towards the output capacity.
Mapping mode for projects with multiple fixtures
When using 1:1 mapping, the output capacity is not affected.
When using interpolated mapping, the content on fixtures with a coarser pixel pitch is scaled
so that the content appears the same size across all fixtures. In this mode, all fixtures are
assumed to have the same pixel pitch as the finest fixture, and the output capacity is
calculated according to the physical dimensions of the fixture.
For example, suppose we have a project with three fixture types:
l

Type A: 5mm pitch, 500mm x 500mm physical size, 100 x 100 = 10000 pixels

l

Type B: 7.8mm pitch, 500mm x 500mm physical size, 64 x 64 = 4096 pixels

l

Type C: 15.6mm pitch, 1000mm x 500mm physical size, 64 x 32 = 2048 pixels
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Figure 4-3. Different pixel pitch fixtures

Fixture type A will count 10000 pixels towards the capacity regardless of whether
interpolated mapping is used, because it has the finest pixel pitch.
With 1:1 mapping, each fixture of type B would count 4096 pixels towards the capacity limit,
but with interpolated mapping it counts the same as a type A fixture of the same size, so
10000 pixels. Fixture type C is the physical size of two type A fixtures, so counts 20000 pixels
towards the limit.
Very small fixtures
Very small fixtures - those with either dimension smaller than 16 pixels - have a high
processing overhead. Therefore the number of these fixtures supported may be fewer than
that calculated from the nominal pixel capacity.

Estimating fixture capacity
When associating fixtures to a project, network load bars are provided to show the load on
each output port. These update in real time as settings such as network bit depth, genlock
frame rate and fixture rotation are updated. See "Network Load" on page 104.
To help with estimating the number of processors required for a project, we have created a
simple web-based calculator tool which models all of the factors outlined above. For further
details please contact support.
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Chapter 5 - Tessera Management Software
The Tessera Management Software is used to configure and control all aspects of Tessera
Processors. The user interface can be accessed in three ways - the local user interface, the
Tessera Remote application and the Tessera Offline Editor.
The user interface is consistent across all three access methods, with only subtle differences
in functionality, which will be outlined in the relevant sections of the manual.

Local User Interface
When using the local user interface the software runs on the processor itself, so no external
computer is required. This is the simplest way of using a Tessera Processor.
To view the user interface, connect a monitor to the Local UI port on the rear of the
processor. This supports DisplayPort monitors, or DVI/HDMI monitors via a suitable adapter.
The minimum supported resolution is 1280x1024 and the maximum resolution is 1920x1080.
The user interface is controlled by connecting a keyboard and mouse to the USB ports on the
front or rear of the processor.

Tessera Remote and Offline Editor
Tessera Remote is a free Windows PC and Mac OS application that allows remote control of
Tessera processors across a network. Additionally the Remote application can be used as an
‘offline editor’, allowing the set up and editing of Tessera projects when away from a physical
processor.
Tessera Remote is downloadable from the Brompton Technology website:
http://bromptontech.com/support#downloads

Note - Tessera Remote Application software versions and the processor
firmware versions must match. If the processor firmware version and
Tessera Remote Application do not match then you will not be able to
connect remotely to the processor.
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Installation for Mac OS X
1. Download the application. It is packaged in a .dmg file. By default this should download to the Download folder.
2. Double click on the .dmg file. This opens up the Tessera Remote .dmg package
3. Drag the Tessera Remote icon into the Applications Folder, or copy (⌘ – C) and
Paste (⌘ – V) the Tessera Remote icon into Applications folder
4. You can have multiple software versions of the Tessera Remote Application on the
same Mac computer. You may find it helpful to store these in different folders
within the Applications folder.

Installation for Windows PC
1. Download the application. It is packaged as a self-extracting .exe file.
2. Double click on the self-extracting .exe file’s icon.
3. This opens the Setup Wizard. Hit Next to continue.
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4. The setup wizard will then ask you for a location.

5. When the application has finished installing then you should see the completion dialog box. Click Finish to finish the installation process.

Network settings for Remote Management
To connect to a Tessera processor you must connect your Mac or Windows PC to a Tessera
processor’s remote network interface via an Ethernet network. As the Tessera processor’s
remote network port supports Auto MDI-X, this network can be as simple as single piece of
Cat 5e cable connected between the Mac or Windows PC and the processor without the
need for a switch. The Remote Application can connect to a processor over a WLAN, but
features like thumbnail previews and video previews will work at a reduced frame rate,
depending on the quality of the signal propagation and the WLAN bandwidth. Connecting
across a WLAN is not recommended when connecting to multiple processors.
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The default IP settings for the processor are 192.168.0.50, with a subnet mask of
255.255.255.0.
For further details on setting IP addresses on Windows and Mac OS, see "Setting IP
Addresses" on page 143

Connecting to a Tessera Processor
Having physically connected the processor to an Ethernet network with a Tessera processor
on, launch the Tessera Remote application. This will open a dialogue box that allows the
user to select whether to start the Remote Application in Remote mode or in Offline Editor
mode.
Clicking the Start Tessera Remote window will start the application in Remote mode.
The application will automatically attempt to detect processors on the Remote network.
Note the software version at the bottom of the screen.
Discovered processors show the user-defined name of the processor, the processor serial
number, the firmware version, the IP address and the name of the project file on the
processor.
To connect to the processor, either double click on the desired processor, or click on a
processor to select it and click on ‘Connect to xxxxx’, where xxxxx is the serial number of the
selected processor.
If the version of Tessera Remote and the processor firmware are not the same, then you may
update the processor firmware to match the version of Tessera Remote you are using across
the network directly from Tessera Remote. To do this select the processor on which you wish
to reload the firmware, and click Reload Processor Firmware.
NB only when the upload has completed and the has been validated will the processor store
the firmware into the internal Flash memory.

Tessera Remote Settings
The Settings Preferences are to allow customisation of canvas and selection settings within
Tessera Remote that are stored locally, which are different to those of the processor itself.
Once connected to the processor, the Remote application functions and looks exactly the
same as the Tessera Management software running on the processor itself.
The top right-hand corner of the main canvas screen shows the status of the connection,
with the name of the processor and its serial number.
When Tessera Remote is connected to the processor the Local Management app running on
the processor cannot be used. You can take control of the processor by clicking on the Take
Control icon.
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Disconnecting from the processor
If you wish to disconnect from the processor, or quit the application, you will be given the
choice of:
l

Leaving the project open on the processor and returning control to the processor.

l

Closing the project on the processor and returning control to it.

l

Shutting down the processor remotely.

Offline Editor
Using Tessera Remote in Offline Editor mode allows projects to be created or edited without
the need to have a physical processor.
When you launch Tessera Remote in Offline Editor mode you are presented with the Offline
Editor menu that allows you to select a recent project or open a recent project, as well as set
canvas settings.
If there are existing projects already saved on your Windows PC or Mac then these will be
listed on the Offline Editor Recent Projects Menu. Just double-click to open an existing
project.
To transfer a project from Tessera Remote to a processor requires the project to be
transferred via a USB flash drive.
When a project created in the Offline Editor is imported to the processor, any fixtures used in
the project will need to be associated with ‘real world’ fixtures. See "Adding Fixtures to a
Project" on page 42 for more details.

Multiple Processor Control
There are three approaches to controlling shows with multiple processors.
Use a single Tessera Remote instance - it is easy to connect and disconnect from different
processors on a network, and the output from the processors will continue uninterrupted
even when Tessera Remote is not connected.
Use multiple Tessera Remote instances - although Tessera Remote only supports
connection to one processor at a time, it is possible to run several instances of application on
the same computer, allowing remote control of several processors from one computer. See
below for more instructions.
Use the Tessera Control application - Tessera Control provides a simple user interface for
controlling multiple processors simultaneously. Controls include brightness, colour, test
pattern, source selection and preset triggering. See "Configuring the processor for DMX
control" on page 93 for more information.
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Running multiple instances of Tessera Remote
When controlling multiple processors from one computer it is preferable to use a fixed IP
address on each processor and on the computer running Tessera Remote. It can also be
helpful to name each processor (see the section on Identification in "Processor Settings" on
page 128.
Controlling different processors is then as straightforward as ‘tabbing’ (Alt – Tab Windows,
⌘ - Tab Mac os) to the relevant instance of Tessera Remote as required.
When running mutiple versions of Tessera Remote on Mac OS it is a good idea to move the
application to the Applications folder and rename the application to 'remote'.
To start Tessera Remote so that multiple instances can be run it is necessary to run Terminal
in Utilities.
Once you have started Terminal, type:
open /applications/remote.app and hit Enter
To run another instance of Tessera Remote type the following into Terminal:
open -n /applications/remote.app

Figure 5-1. Windows PC side by side application instance
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Figure 5-2. Alt-Tab allows the user to select the relevant instance.

Figure 5-3. In Mac OS ⌘ -Tab to select the relevant instance.

- 36 -

Chapter 6 - Project Setup
Creating A New Project

Figure 6-1. The New Project Window

The New Project Wizard is launched each time you start a new project on the processor,
Tessera Remote or the Offline Editor.
1. To start a new project, click New… in the Start Screen or in the Project menu in the
Main Project Screen. This will launch the New Project Wizard.
2. Using the wizard, enter a name for your project.
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3. If you are using the Offline Editor in Tessera Remote, you can change the location of
where the project is saved. If you are using the processor locally or remotely, the
project will be saved to the processor’s internal storage. To save the project on to a
USB flash drive or an other USB storage device you will need to export it. See "Project Management" on page 41
If you are creating a project with only one fixture type:
1. Select the manufacturer and fixture type from the dropdown menus.
2. Specify the width and height of the array of fixtures to be generated automatically.
Alternatively, you may uncheck the Create an array of fixtures tickbox and add fixtures manually once the project is created.
3. Select the topology from the dropdown menu or leave this at the default setting if
you want to add the topology manually once the project has been created.
4. Click Create to complete the new project wizard and open the new project.
If you are creating a project with more than one fixture type:
1. Click Go to Advanced View and select the fixture types you require from the list
using CTRL+ click. If the required fixture type is not listed, you may import it by clicking Import Types… (see below for more information).
2. For 1:1 pixel mapping, check the Map pixels directly to the canvas (1:1) tickbox. See
"Mapping Options" on page 40
3. The M2 supports a 1920x1080 raster by default, but can also be set to 1080 x 1920,
1600x1200, 2880 x 720 and 720 x 2880 by selecting this from the drop-down menu
in Canvas Size. Using these alternative resolutions puts the processor in to Low
Latency Mode. See "Low Latency Mode" on page 106 for the implications of using
this mode
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Figure 6-2. Selecting a canvas size from the Advanced View

1. In the advanced mode, you do not have the option of automatically generating an
array of fixtures - the fixture types you have selected will be available in the library
once the project has been created. Click Create to complete the wizard and open
the new project.

Note - Once a project file has been created it is not possible to change the
included fixture types, mapping method or canvas size. The creation of a
new project is required to change these properties.
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Importing New Fixture Types
You may find from time to time that it is necessary to import a fixture that is not included in
the library. To import a fixture you will need the Fixture Definition File, which is a .xml file.
1. Insert a USB flash drive containing the Fixture Definition File in the processor.
2. Open the New Project Wizard by clicking New... and go to the Advanced view.
3. Click Import Types...
4. Using the browser, locate the Fixture Definition File on the USB flash drive and
import it by clicking Confirm.
All imported fixtures are marked with an asterisk in the fixture list in the New Project Wizard.

Note - When importing new fixture types it is important to ensure that
they are compatible with the installed version of firmware if not included.
Please contact Brompton Technology if you are unsure or experience
trouble importing new fixture types to a processor.

Mapping Options
Interpolated Mapping
When multiple fixtures are added, the processor will by default automatically adjust the
scaling for each fixture type so that video appears the same physical size on all fixtures,
regardless of pixel pitch.
It's worth remembering in this mode when different pixel pitches are scaled to match each
other it may not be possible to place as many fixtures in the Canvas as would have been the
case without interpolated mapping. If this is an issue it may be desirable to use 1:1 mapping.
Please see "Network Load" on page 104 for the implications on network load of Interpolated
Mapping.
1:1 Mapping
In some cases where multiple fixtures are used it may be desirable ignore the physical size of
each fixture and instead map video content directly to the LED fixtures. In this mode it is the
resolution (i.e the number of LEDs) that determines the size of the fixture on the canvas, not
the physical dimensions. This may be because content has already been prepared with the
correct scale for each product or to allow more fixtures to be placed in the canvas.
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To do this check the box marked “Map pixels directly to the canvas (1:1)” in the advanced
view of the New Project Wizard (see "Creating A New Project" on page 37).

Project Management
Opening and Importing Projects
To open a project that is stored on the processor, you simply click Open... from the Start
Screen menu or File drop-down menu in the Main Project Screen and select the project from
the list. If the project you wish to open is not already stored on the processor you will have to
import it.

Figure 6-3. Importing projects in the project management window.

To import a project if you are using the processor with a locally connected keyboard, mouse
and monitor:
1. Insert the USB flash drive containing the project file into one of the available USB
ports on the processor.
2. Click Open... on the Start Screen or in the File drop-down menu in the Main Project
Screen. This will display the Project Management window.
3. When you have selected the file, click OK. This will copy the project file on to the pro-
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cessor and display it in the list of projects stored on the processor.
4. Select the file from this list and click OK to open it.
To import a project if you are connected to the processor via Tessera Remote:
1. Click Import Project... in the project management window and navigate to the project file you wish to load, either stored on the remote computer's hard drive or inserted removable media.
2. When you have selected the file, click OK. This will add the project file to the list of
projects stored on the processor.
3. Select the file from this file and click OK to open it.

Deleting Projects
1. Click Open... on the Start Screen or from File drop-down menu in the Main Project
Screen. This will display the Project Management window.
2. Select the project or projects (hold Ctrl to select multiple files).
3. Click Delete Projects. The selected files will immediately be removed from the processor.

Adding Fixtures to a Project
There are two main workflows for adding fixtures to a project - offline project creation and
on-site project creation. Users can use whichever workflow is most convenient for their
project, including a combination of the two.
In the offline workflow, use Tessera Offline Editor to create the project file and to add and lay
out fixtures in the project, using the add-fixtures-from-library tool. When on-site and the
fixtures are physically connected to the processor, it is then simply a case of transferring the
project to the processor, and associating the real world fixtures with the fixtures in the
project, using the add-fixtures-from-network tool. This workflow is useful if the fixture layout
is complicated, and/or if detailed information about the fixture layout and cabling is available
ahead of arriving on site.
In the on-site workflow, the project and fixture layout are created on a processor with real
fixtures already physically connected. In this case use the add-fixtures-from-network tool to
take an online fixture and add it to the canvas. This workflow is more useful if the fixture
layout is simple or not known ahead of time.

Add fixtures from library
Use this tool if the fixtures are not already physically connected to the processor, or when
using Tessera Offline Editor.
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Click the toolbar icon, select the desired fixture type, then click on the canvas to add the
fixture. The Rotation field is provided to rotate fixtures before placing them. Enable the Join
Fixtures option to have the about-to-be added fixture joined to the previously added fixture.
Click the back arrow when finished.
To add a rectangular array of fixtures, ensure the Rotation is set to 0˚, and click and drag to
draw out an array of the desired size. The array can be resized by dragging at the edges of
the array, or moved by dragging when hovering over the array, when the hand cursor
shows. The toolbar shows the available topology options. When finished, click the tick
button to save the array, the cross button to delete it.

Add fixtures from network
Use this tool when the fixtures are already physically connected to the processor, either to
associate with fixtures added offline, or to add online fixtures directly to the canvas.
After clicking the Add Fixtures From Network button, the toolbar will show the detected
strings of panels, grouped by output port. A string is a continuous daisy-chain of Tessera
fixtures, so if a network switch is used to split a signal, each output of the switch will be
detected as a separate string. Each string will be coloured in the user interface, and the
panels will be illuminated to match. The number in the string icon indicates the number of
detected fixtures. An example is shown below.

Figure 6-4. An example of a Tessera system topology.
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Hovering over a string icon will cause the corresponding fixtures to be highlighted white, for
easier identification. Once you have chosen a string, click it to start placing it. You will then be
prompted to place each fixture in the string in turn. The fixture currently being placed will be
illuminated white.
Adding fixtures directly to the canvas works similarly to adding fixtures from the library. For
information on this, refer to the previous section.
To instead associate with a fixture which is already on the canvas, simply select the online
fixture then click on the relevant fixture on the canvas. If the fixtures on the canvas already
have topology information, you will be prompted to associate the rest of the string
automatically, which you can do by pressing enter. If you only wish to associate part of the
string, hold the shift key and select the last fixture you wish to associate. Alternatively
you can continue to associate fixtures individually by clicking on each fixture on the canvas in
turn.
It is also possible to associate with fixtures on the canvas which already have a fixture
associated. In this case the old fixture will be disassociated before the new fixture is
associated.

Sub-Fixtures
For some fixture types, each fixture does not have its own Tessera interface, instead multiple
fixtures are connected to a single power supply / control box. These fixtures, for example
strips and small tiles, are represented in the Tessera system as sub-fixtures. The power /
control boxes are called root nodes.
Each root node contains a Tessera Receiver Card, and like normal panel-type fixtures is
connected to the rest of the system over daisy-chained Gigabit Ethernet. Root nodes
connect to sub-fixtures using a proprietary data/power connection.
Sub-fixtures may be individually positioned and rotated on the canvas, just like normal
fixtures.
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Figure 6-5. Sub-fixtures being used with conventional LED panels.

Root nodes are not typically able to detect what types and quantities of sub-fixtures are
connected to their outputs, and therefore must be told by the processor. This is achieved by
adding root nodes to the canvas.
Using the add-fixtures-from-library tool, described in "Adding Fixtures to a Project" on
page 42 add a root node to the canvas. Pressing the Tab key or clicking the Next Port button
switches to adding sub-fixtures to the first output port of the root node. Repeated presses
of Tab or the Next Port button advances through the ports, before returning to adding root
nodes or panels to the Tessera string.
Note that root nodes are limited in terms of the types, quantities and combinations of subfixtures that can be connected to their outputs. These constraints will be enforced when
adding sub-fixtures to root nodes. See the fixture manufacturer's documentation for more
information.
The edit topology tool can be used to modify the connections between root nodes and/or
sub-fixtures after they have been added, see "Changing Topology" on page 47 for more
information.
Once the root node and fixture layout has been completed, and the fixtures have been
connected to the processor, the root nodes can be associated. Strings of root nodes appear
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the same as strings of normal panels in the add-fixtures-from-network tool, described in
"Adding Fixtures to a Project" on page 42. When a root node is associated its outputs will
automatically be configured with the correct types of sub-fixtures, and the sub-fixtures will
automatically be associated. It is not normally necessary to individually associate subfixtures.

Sub-fixture test patterns
Test patterns may be enabled on sub-fixtures in the same way as normal fixtures, via the
fixture properties pane. Different patterns can be enabled on each sub-fixture, but note that
if test patterns are enabled on one sub-fixture, all other sub-fixtures on that root node will
cease to display live video.
A small subset of simple solid-colour test patterns can also be enabled on root nodes. All of
the root node's output pixels, including those that are not currently configured/associated
to sub-fixtures, will be illuminated.

Understanding Topology and Association
Tessera processors are able to detect the topology of connected fixtures, i.e. the order in
which fixtures are connected, which port on the processor they are connected to and if
fixtures are broken into strings by switches. Topology is used to help users associate online
fixtures with fixtures in their project.
Fixtures are identified by a unique MAC address. When a real fixture is associated with a
fixture in the project, the MAC address is recorded and this association persists until the user
decides to change it.
Topology is only used to assist with association. So if the real-world topology is changed
after fixtures are associated, for example because a wall is re-cabled, the association will not
automatically be changed. If topology errors are turned on, then any changes will be
highlighted in red on the canvas.

Swapping Fixtures and Correcting Association
Each fixture connected to a Tessera processor is recognized as a unique fixture. Each unique
fixture is associated with a position on the canvas. If a tile goes offline or is removed, the icon
of that fixture remains in the canvas but there is now no fixture associated with it. The green
dot (showing that the panel is online) will now go white. In instances where a fixture is
swapped out from the middle of a string the processor can see that a fixture has
disappeared and a new fixture has appeared in the same position. It draws the conclusion
that a swap-out has taken place and will offer the user the option to correct association.
To perform the swap-out of one fixture:

- 46 -

1. Disconnect and remove the faulty fixture or controller box.
2. Insert and connect a good fixture into the same position in the string.The processor
will prompt with:

Figure 6-6. The correct association dialog box

3. This message will be on screen for 10 seconds. After this time you can find the Correct Association option by right clicking on the icon of the affected fixture or by
selecting Correct Association from the Edit menu.
4. Click on the blue Correct Association button.

Changing Topology
It is possible to change the topology manually using the Topology toolbar if the drawn
topology does not match the actual sequence of fixtures. An example of where this might be
useful is a touring production where a screen has been rebuilt at the second venue of the
tour with a different cable layout to that used at the first venue. These instructions assume
the panels are powered and connected and the mistake has just been noticed.
In our example, at the first venue the panels were cabled in a continuous lace from left to
right and from bottom to top as viewed from the front of the screen ("First venue
topology." below).

Figure 6-7. First venue topology.
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Owing to a mistake during the load in at the second venue the panels are now cabled
differently ("Second venue topology." below). It will be too time-consuming to re-cable the
screen correctly so another solution must be found

Figure 6-8. Second venue topology.

To correct a screen follow the following steps:
1. On the canvas select all the panels that have the wrong topology. Right click on
one of the panels and select Disassociate.
2. Now click the Edit Topology button to view the Topology toolbar
and select the string of fixtures you wish to correct by double clicking on the dot in
the centre of one of the panels. The whole string will now be coloured red.
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Figure 6-9. The topology is drawn on all panels in the string.

3. The strike in the Remove Link button will change from grey to red once a string is
selected indicating that it can now be used.
Click on it to remove the topology.
4. Now hover your mouse over the centre spot of the fixture which is to be at the
start of the string. Click and hold the button and drag the pointer to the centre
spot of the second panel on the string. A dotted red line will be drawn which will go
solid as the line becomes pinned to the centre spot of the next panel in the string.
You can now move on to the third fixture in the string and so forth until the string
is complete.
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Figure 6-10. Changing the topology by clicking and dragging the
mouse pointer

5. Return to the main project toolbar by clicking on the green arrow. The processor
will recognise that there is a new topology which doesn’t match the current association and will display the Correct Association message for 10 seconds.

Figure 6-11. The Correct Association message

6. Click the Correct Association button to finish the process. The fixture icons will display the green dot in the canvas window and content can be displayed on the fixtures "The panels are online and associated." on the next page).
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Figure 6-12. The panels are online and associated.

After this time you can correct association by right clicking on the icon of the affected fixture
or by selecting Correct Association from the Edit menu.
Alternatively you can display the Add Fixtures from Network toolbar to see the unassociated
fixtures icon highlighted with a colour. Click on this icon and then click on the first fixture in
the string to associate the fixtures. Now click on the green arrow to come out of the Add
Fixtures from Network toolbar and the fixtures will associate and come online.

Fixture Layout
Selecting Individual Fixtures
To select a fixture simply click on it. The fixture will turn blue and information such as
manufacturer, type and position is displayed on the Properties tab. You can also right-click
on a fixture to display a context menu.

Selecting Multiple Fixtures
There are various methods of selecting multiple fixtures:
l
l

l

Hold down the Ctrl key and click fixtures to select them.
Alternatively, hold down the left mouse button and drag a selection box around the
fixtures to select them (see Selection Mode info box below).
To select all fixtures on the canvas, you can use CTRL + A.
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Note - Selection Mode In Settings > Preferences you can change the
selection mode from Inside selection area to Overlaps selection area. If
'Inside selection area' is enabled, the line must completely enclose fixtures
in order to select them. If 'overlaps selection area' is enabled, a fixture will
be selected if any part of it falls within the selection area.

Grouping Fixtures
If there are several fixtures in your configuration that you always want to move and adjust
together, it may be helpful to put them into a group. To do this select the required fixtures,
right-click and choose Group from the dropdown menu. You can also Ungroup in a similar
manner.
Fixtures can also be added or removed from groups, by selecting a fixture, right-clicking, and
selecting Add to group or Remove from group.

Note - If a group is destroyed by ungrouping or removing the only fixture,
and the group is used in a position preset, the preset will also be
updated/deleted accordingly. You will be warned that this is about to
happen. Any colour overrides associated with that group will be lost.

Moving Fixtures
You can move fixtures anywhere on the Canvas, either within or outside of the Active Area,
by selecting the fixture and dragging or pressing the arrow keys on the keyboard. Pressing
the arrow keys will move the fixture by grid-space increments if the grid is displayed and snap
to grid is enabled or, if not, by pixels.

Rotating Fixtures
Fixtures can be rotated in three ways:
Fixtures can be individually rotated around their top-left corners by selecting them and
entering the degree of rotation in the properties tab.
Groups can also be rotated by selecting them and entering the degree of rotation in the
properties tab. Groups rotate around their anchor point, indicated by a small circle that is
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placed by default in the centre but can be moved by dragging on the canvas or using the
Rotation Center settings in the Properties tab.
A selection of multiple fixtures can also be rotated together without needing to group them.
To do this, select the fixtures then select the toolbar icon, or press Ctrl+Shift+R (or
Cmd+Shift+R on Mac). A moveable rotation anchor will be placed in the centre of the
selection, with a handle which will be dragged to rotate the selection, with the Shift key
enabling finer-grained rotation.

Figure 6-13. Multiple fixture rotation toolbar icon

Note - The S4 processor can only rotate in 90 degree increments.

For further information on how rotating fixtures affects network load see "Output Capacity"
on page 28.
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Main Project Screen

Figure 6-14. Main Project Screen

1. Drop-down menus
2. Left Toolbar:
l

Undo and Redo

l

Zoom In and Out

l

Add Fixtures

l

Add Fixtures from Network

l

Change Topology

l

Record Preset

3. Source Previews
4. Processor Name/ Processor serial number
5. Right Toolbar:
l

Canvas Mode

l

Live Control On/Off

l

Pause/Freeze
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l

Blackout

l

Test Patterns

6. Property Tabs
7. Presets
8. The Canvas

Moving Around the Canvas
Up and down

vertical scrollbar arrow keys
page up/down keys
mouse wheel

Left and right

horizontal scrollbar
arrow keys
shift + mouse wheel

Zoom in and out
Drag the canvas

mouse wheel + Ctrl
right-click and select Zoom to fit, Zoom 1:1 or Zoom to selection
Hold the space bar and left click + drag the mouse

- 55 -

Navigator

Figure 6-15. Canvas with Navigator enabled

The navigator provides a quick and easy way of moving around the canvas and adjusting
zoom levels. Toggle Navigator on/off using the button at the intersection of the canvas
scrollbar, by selecting Toggle Navigator from the View menu, or by pressing
Ctrl+Shift+N (or Cmd+Shift+N on Mac).
Navigator provides a mini simplified preview of the whole canvas, with a red box showing the
currently visible canvas area. Dragging the box moves the canvas view, and a slider is
available for zooming in and out.

Using the Grid
The grid is a useful tool to help align or space fixtures evenly on the canvas. Enabling Snap to
Grid will pull fixtures into perfect alignment at all times.
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The grid can be displayed by right-clicking on the canvas in the Main Project Screen and
toggling Show Grid in the context menu. Snap to Grid can be enabled in the same way.
These options can also be accessed in Tools > Settings > Preferences. Selecting Properties
from this right-click menu, displays grid colour and spacing options in the Properties tab on
the right-hand side of the screen when the canvas itself is selected.

Snap to Fixtures
When laying out fixtures on the canvas it is often helpful to be able to place them exactly
adjacent to one another without spaces between them. When Snap to Fixtures is enabled a
fixture will be pulled towards other fixtures it is dragged near. This option can be accessed in
Tools > Settings > Preferences or by right-clicking on the canvas and toggling Snap to
Fixtures in the context menu.

Canvas Modes
Canvas modes can be selected by clicking on the Canvas mode icon on the toolbar and
selecting the relevant mode from the drop-down menu or by using the assigned keyboard
shortcut.

Edit Modes
The edit modes allow fixtures to be positioned on the canvas.
Edit Mode:
(keyboard shortcut F1)
Edit Mode is the default mode for the canvas and allows fixture positioning. In Edit mode the
fixtures are displayed as viewed from the front.
Rear Edit Mode:
(keyboard shortcut F2)
Fixtures are commonly cabled up from behind and Rear Edit allows fixtures on the canvas to
be horizontally flipped, as if viewed from behind. This is particularly helpful for figuring out
and fault-finding topologies.
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Figure 6-16. Edit Mode

Figure 6-17. Rear Edit Mode
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Video On Canvas Modes
Video on Canvas modes allows the display of the currently selected video input, taking into
account Viewport and Active Area settings. Video on Canvas Modes are not available on
Tessera Remote. Fixtures cannot be moved on the canvas whilst in Video on Canvas Modes.
Fixture Only Mode:
(keyboard shortcut F3)
Fixture only mode displays the currently selected video input as it is being displayed on the
fixtures.

Figure 6-18. Fixture Only Mode

Video and Fixture Mode:
(keyboard shortcut F4)
Video and Fixture Mode displays the currently selected video input on both the fixtures and
the canvas. The video within the Active Area that is not being displayed on the fixtures is
shown greyed out as shown in the picture below.
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Figure 6-19. Video and Fixture Mode

Video Only Mode:
(keyboard shortcut F5)
Video Mode displays the currently selected video input within the Active Area on the canvas
without displaying the fixtures.
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Figure 6-20. Video Mode

Figure 6-21. Video Mode with scaled input
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Layers

Figure 6-22. The Layers tab

Layers are an easy way of manipulating overlapping fixtures.
Fixtures can be assigned to layers which have a z-order. Z-order refers to the front to back
ordering. Assigning panels to layers that make tasks such as On Screen Calibration (OSCA)
and other fixture based adjustments easier. Layers are particularly useful when two groups
of panels are superimposed on the canvas, so that the content can be easily duplicated on
two sets of fixtures, much as in a Imag screen application, with two screens showing the
same content on either side of the stage. Layers make it easier and more accurate to select
between the two groups of panels to make OSCA or other panel based adjustments.
The tick allows you to show or hide layers without effecting the output. Clicking and
dragging a highlighted layer up or down allows the z-order of the layer to be adjusted.
Layers should be assigned when associating fixtures. See "Adding Fixtures to a Project" on
page 42. To do this you should be in the Add Fixtures from Network window. Select the
relevant layer you wish to add fixtures to. You can create a new layer by using the Add Layer
button in the Layer Tab.
With the relevant layer highlighted, add the required fixtures from network. To add fixtures
to a new layer, select the layer and add the fixtures to that layer.
A total of 999 layers can be created.

Project Data Export
Sometimes it may be useful to export data from a project, for example for use in a content
creation system, or to use as a cabling diagram. It is possible to export data in two formats image and comma-separated values (CSV).

Image export
To export an image, select Export Canvas Image from the Tools menu. There are a number of
options which control how the exported image is rendered. After choosing the options you
will be prompted to select an export location, either on the local file system when using
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Tessera Remote or on a USB key attached to the processor when using the local user
interface.
The exported image, which will be in PNG format, will be a pixel-accurate representation of
the canvas and therefore the image will have the same dimensions as the canvas.

Note - If using the exported image for content creation, we recommend
using the image as a guide only rather than a mask. This will avoid
artefacts due to aliasing at the edges of small and rotated fixtures.

CSV data export
To export data as a CSV file, select Export Fixtures from the Tools menu. The CSV file will
contain a row for every fixture on the canvas. To choose the columns, select fields from the
left hand-list and press >> to move them to the right-hand list. After choosing the fields you
will be prompted to select an export location, either on the local file system when using
Tessera Remote or on a USB key attached to the processor when using the local user
interface.
The exported data can be opened and manipulated in spreadsheet applications such as
Microsoft Excel, or in simple text editors.
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Chapter 7 - Input Properties
Sources
SDI Inputs
The M2 processor has two SDI inputs.
The SDI A and SDI B inputs are identical in functionality. Each input provides SD-SDI, HD-SDI
and 3G-SDI (both level A and level B). Alternatively, both inputs may be used together for
dual-link HD SDI. All common broadcast resolutions are supported, including 720p50/60,
1080i50/60 and 1080p50/60 and fractional frame rates such as 59.94. For a full list
"Supported Resolutions" on page 140.
The physical connections to the SDI A and B inputs are via standard BNC connectors and in
addition to each input there is a re-clocked thru connector which allows the daisy chaining of
a signal to a second processor or monitor.
There is also an active SDI Out for each channel which is for future implementation.

DVI Input
The M2 processor is fitted with a DVI-I input, but the T1 and S4 processors have a DVI-D input.
All Tessera procesors are capable of receiving digital (DVI-D) signals up to full HD 1080p60
resolution at frame rates from 24Hz to 60Hz to a maximum pixel clock of 148.5MHz.
The M2 processor is also capable of receiving analogue VGA/RGBHV inputs up to full HD
(though for this you will need a suitable adaptor for the DVI-I input port).
The DVI-I input may also be used to receive standard definition or high definition component
video (YPbPr) via a passive DVI to BNC breakout cable. In addition to the DVI-I input there is
also a re-clocked DVI-I output.
HDMI can be supported by use of a suitable adapter, however, the Tessera processors does
not support HDCP.

Source selection
The three video inputs on the Tessera M2 processor are mapped to two input pipelines to
allow crossfading between sources.
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Although it is possible to crossfade from input to another ("Crossfading (M2 only)" on
page 75), it is not possible to display multiple inputs simultaneously, either as picture-inpicture or as discrete windows.
The incoming video on each of the three inputs can be quickly viewed in the Main Project
Screen where you will see the three Input Thumbnails ("Source preview thumbnails."
below).

Figure 7-1. Source preview thumbnails.

The currently selected input will have its legend highlighted in blue. The quickest way to
change inputs is to double click on the input you wish to switch to. Alternatively, you can
click on the Input tab to see the Source drop down menu and select the different inputs from
here.
As T1 and S4 processors only have a single DVI-D input, this is always selected.
Any of the inputs may be used as a reference signal for genlock (See section "Genlock
Settings" on page 105).

Scaling and Cropping
The Tessera M2 and T1 processors achieve scaling and cropping of the incoming feed by use
of three settings in the input tab: Viewport, Zoom and Active Area. Scaling and cropping are
not supported on S4 processors.

Viewport
The Viewport settings define the region of interest of the incoming feed which is captured to
the canvas. Typically this will be captured in full, so an incoming HD feed would have settings
of:
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Figure 7-2. Incoming 1920x1080 video at its original size.

If however you wish to capture only part of that incoming feed (perhaps because you then
wish to expand the image to fill the canvas) you can set these values accordingly.
For example, if you wished to capture a window of PAL content being displayed towards the
bottom right corner of an HD feed you might set the Viewport to:
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Figure 7-3. Viewport set to bottom right corner

In addition to the left, top, width and height parameters there is also a Snap to Input button.
This automatically sets the width and height to match the full size of the incoming video
feed.

Active Area
On the canvas, the Active Area is indicated by the pale grey area with a dashed border ("The
canvas with the Active Area shown by a dashed border." on the next page). Settings are
found on the Geometry section of the Input tab.
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Figure 7-4. The Geometry Tab

Figure 7-5. The canvas with the Active Area shown by a dashed
border.

Having determined the region of interest to be captured from the incoming feed using the
Viewport, that region can then be sized or moved to the appropriate part of the canvas.
To set the Active Area to the same dimensions as the Viewport click the Snap to Viewport
button. Content will be shown with no scaling but with cropping according to the Viewport
Settings. As with the Viewport setting, the Active Area will default to the same parameters
as the incoming video feed.
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To scale the content, you can set the Active Area dimensions to values greater or smaller
than the Viewport. You can change the size of the Active Area by dragging the dashed line
on the canvas or entering values in the Width and Height fields. The active area may not be
greater than what the maximum canvas size has been set to.
To change position use hand cursor or adjust the top left coordinates manually.
Snap Active Area to Selection
To automatically size the incoming image to fit on a particular group of fixtures, select the
chosen fixtures and click the Snap to Selection button
The Active Area will then be sized and positioned to fit over the selected fixtures.
4:3 and 16:9
The 4:3 and 16:9 buttons will automatically adjust the width parameter of the Active Area to
the chosen ratio based on the height. For example, if the Active Area dimensions are width
200 x height 90, clicking the 16:9 button would reduce the width to 160 and the height
would remain 90.
Zoom
The Viewport is scaled and mapped onto the Active Area according to the Zoom mode. The
zoom options are:
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1:1

The original Viewport image size.

Fit

The aspect ratio of the Viewport is maintained
with the image scaled to fit within the active
area.

Fill

The aspect ratio of the Viewport is maintained
with the image scaled to fill the active area.

Stretch

The image is scaled to the exact dimensions of
the active area without maintaining aspect
ratio.

Input Colour Control
Black Level
The black level control affects the base level of brightness of the darkest content in the
incoming feed. Lowering this value will make all parts of the image look darker (except for
white) but will be most pronounced at the lower end of the video signal nearest black. For
optimum adjustment of the black level a PLUGE or greyscale line-up pattern can be useful.
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Note - What is PLUGE? Picture line-up generation equipment (PLUGE or
pluge) is equipment used to generate greyscale test patterns in order to
adjust the black level and contrast of a picture monitor. Images generated
from these tools can be saved and stored as bitmaps and these images are
sometimes referred to as PLUGE themselves.

Contrast
Just as the black level control sets the threshold of the base level of dark content, the
contrast slider sets the threshold level of bright content. Boosting this level will increase the
differential in luminance between the darkest content and the brightest content.

Hue
The hue parameter of the input controls allows the user to adjust the spectrum of the
incoming video feed. At the extreme this will reverse the colours assigned to each area of a
given hue.

Saturation
The saturation parameter determines the level of colour in the image and can be used to
increase or reduce this. At the extremes this would make the image monochrome with only
brightness information intact or boost its colour to give a more colourful (perhaps too
colourful) image.

RGB Shadow
In addition to being able to set a black level for a given input it is also possible to set the
black level specifically for each of the primary colours in that input. These sliders, called RGB
Shadow, equate to a setting for the black level of each specific colour.

RGB Highlight
In addition to being able to set contrast for a given input it is possible to set a contrast (white
level) for each of the primary colours also. These parameters are called RGB Highlight.

Histograms
A useful tool offered by the Tessera processor is a selection of histograms. Histograms
depict distribution of pixels across the possible range of a colour or colours of the incoming
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video feed in real time after they have been modified by the input colour controls. There are
six different histograms available:
l

Luminance

l

Red

l

Green

l

Blue

l

Red, green and blue and luminance with separate histograms

l

Red, green and blue luminosity with overlaid histograms

All histograms can be displayed linearly or logarithmically.
Their main use is to allow the user to identify and compensate for perceived deficiencies in
the incoming video feed. The user can then see how changes to the input colour controls
may be affecting the colour content of that feed. By adjusting those controls it may be
possible to boost the amount of colour depth of the displayed signal, resulting in a better
distribution of peaks in the histogram.
The X-Axis of each histogram is graded from 0% to 100% and shows a column to indicate how
much content there is at that percentage of the given colour. The Y-Axis showing the
amount of content at a particular percentage is auto-ranging in scale and adapts to fill the
axis.
The logarithmic scale will accentuate small columns so tiny areas of a particular colour can
be visualized in instances where one particular percentage dwarfs all others.

Figure 7-6. Test pattern showing colour bars at 75% and the corresponding Linear RGB histogram.

The above picture shows a test pattern and its corresponding Linear RGB histogram. Note
that there are clear columns at 75% for each of the three primaries. This is because all of the
colours are either primary colours at 75% (red, green and blue sections) or secondary colours
made from combinations of the primaries at 75% (cyan, yellow, magenta and white sections).
There is also a large peak at 0% on the left which shows how much black there is in the image
(quite a lot) and also a clear peak on the right which shows an area of 100% RGB and is
caused by the single block of 100% white towards the bottom left of the image (you can see

- 72 -

this white is noticeably brighter than the grey-looking vertical section white is made by
mixing 75% red, green and blue).

Figure 7-7. Test pattern showing colour bars at 75% and the corresponding Logarithmic RGB histogram.

The above picture shows a logarithmic visualization of the input. Although the same three
areas 0%, 75% and 100% show the highest concentrations of columns there are now more
areas visible. So we can see that there are some small amounts of colour which deviate from
these three values and the image is not quite as perfectly composed of 75% colour as might
have been assumed from the linear scale.
The fact that the peaks corresponding to the black and white areas of the input image are
located at the very start and end of each histogram indicates that this content source is well
balanced and the full spectrum is being used.

Setting Colour Controls with the Aid of Histograms
The histograms can be useful in determining if a particular incoming signal is filling the entire
spectrum of colour and brightness.

Note - When choosing an image to balance, it is wise to either use an
image which is similar to the content you plan to show throughout your
project, an image with a wide variety of colours and hues, or a suitable test
pattern.
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Figure 7-8. A fairly washed out incoming signal on SDI-B (see
thumbnail top left) with the corresponding histogram for red,
green and blue when the Input Colour Controls are set to default.

Figure 7-9. Adjusting the black level control will make the blacks
look darker and the concentrations of colour now reach down to
0% on the scale.
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Figure 7-10. Adjusting the contrast control will make brighter
areas appear closer to the 100% threshold, assuming you have
some areas of white content in your image and this is desirable.

If specific colours do not appear to be rendering correctly you may wish to adjust the RGB
Highlight and Shadow controls to work on that specific colour without affecting the other
two primaries. At this point it may be helpful to look at the histogram for each colour
individually.

Crossfading (M2 only)
Crossfading between inputs is achieved by storing the different inputs as presets with a
crossfade time. To store presets to crossfade from one input to another follow these steps:
1. Select the input you wish to create a preset for (all tiles will change to this input).
2. Click the preset record button. If the tiles of the group are selected they will appear
red. If they appear with diagonal striped lines select them again.
3. Now hit the Preset button on which you want the new preset to reside. Right-click
the preset to rename it.
4. Click on the input thumbnail of another input to change to that input.
5. Repeat steps 1-4 to create a new preset for this input.
6. Now right-click on each preset in turn to see its properties and to set a fade time for
the preset.
You are now ready to use the presets you have created to crossfade between the inputs.
*As inputs are global to all tiles it will not matter if all the tiles in the system are in this group
or not. Selecting the resulting preset will always change the input for the entire system.
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Note - What happens when you change inputs on the M2? The M2
processor has two input pipelines each of which can process up to a
1920x1080p raster at 60Hz. When an input is selected, that input gets
mapped to the currently unused pipeline and this is then fed into the
mixer and scaler functions of the processor further down the line. Once
any crossfading is complete the other pipeline is then free for the next
selected input, as and when that is chosen.
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Chapter 8 - Colour and Brightness
There are several ways to modify the colour and brightness of fixtures connected to the
Tessera system. The correct controls to use will depend on the source of the problem to be
addressed, or the creative effect desired.
l

l

l

l

l

Global colour - the controls on the Colour tab will affect all fixtures connected to the
processor, except where per-fixture or per-group overrides are active. See "Global
Colour" below.
Per-fixture and per-group colour override - colour and brightness settings can be
overridden for specific fixtures or groups by enabling the Override Global Colour
option on the Properties tab. See "Per-fixture and Per-group Colour Override" on
page 80.
Input colour - provides controls for modifying the colour balance of a specific input
(DVI, SDI or analogue). See "Input Colour Control" on page 70.
On-Screen Colour Adjustment (OSCA) - discussed in "On-Screen Colour Adjustment"
on page 115, OSCA provides a way of compensating for colour mis-matches between
modules and the appearance of bright or dark seams.
ChromaTune - discussed in "ChromaTune" on page 81, ChromaTune provides tools
for making more precise tweaks to specific colours in an incoming video feed.

Global Colour
The following controls are available in the Global Colour tab, and apply to all fixtures in a
project unless those fixtures (or groups) have been overridden as described in "Per-fixture
and Per-group Colour Override" on page 80.

Intensity Gain
The Intensity Gain slider allows users to modify the light output of all the fixtures in the
system in a perceptually linear way, so at 50% fixtures will look half as bright to the naked eye
as they did at 100%. The precise light output of the screen will depend on this value in
conjunction with the Brightness slider.

Brightness
The brightness scale allows adjustment of the light output of the screen. As all fixture types
are calibrated when the profile is written, the brightness scale is expressed in Nits
(candela/m2). This means arrays with different fixtures can quickly be set to the same output
level.
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Where more than one type of fixture with different maximum brightness values is used, the
slider will cease to have an effect on a fixture's brightness once its maximum value is
exceeded.
The brightness slider will have a default value of the brightest value that all the fixtures in a
project can reach. Therefore if a project consists of two different types of fixtures, one of
which has a maximum output of 5000 Nits and one of which has a maximum brightness of
2000 Nits the default value of the brightness slider will be 2000 Nits. Similarly the maximum
value of the slider will be the value of the brightest fixture in the project, so in this example it
would be 5000 Nits.

Note - If you wish to control the brightness of an array including different
types of fixtures whilst maintaining their relative brightnesses then this is
best achieved by leaving the brightness slider at default and modifying the
intensity slider.

RGB Gain
The RGB gain controls allow the user to adjust the level of each of the primary colours in the
output to the connected fixtures. Their default value is 100%.
Adjusting all 3 RGB sliders to 50% would have the same effect on perceived brightness as
lowering the Intensity slider to 50%.

Colour Temperature
The Temperature slider allows the user to adjust the white balance of the fixtures attached
in a range from 2,000-11,000 Kelvin.

Gamma
Gamma can be modified in a range from 0.2 up to 4.0. The default gamma setting of the M2 is
2.35.
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Note - Gamma or gamma correction is a way to adjust how bright the
midtones in the image appear without affecting the very dark or very
bright areas of the image. A higher value results in lower brightness. If
images are not gamma encoded, they allocate too many bits or too much
bandwidth to highlights that humans cannot differentiate, and too few
bits/bandwidth to shadow values that humans are sensitive to and would
require more bits/bandwidth to maintain the same visual quality. By
increasing the differential between areas of shadow and light in certain
parts of the luminance curve of a particular piece of content it is possible
to increase the amount of detail that can be perceived by the eye, thus
rendering the image in more detail and with more contrast. This gamma
correction is done by a simple function. In most computers images are
encoded with a gamma constant equivalent to about 0.45 and so are
decoded with a gamma of approximately 2.2. Mac computers used to be
encoded at 0.55 and hence decoded at 1.8. This is why it often helped to
set a lower gamma value on the output of a display when it was
connected to a MAC computer source for best results. Since the Mac OSX
Snow Leopard release Apple have changed their default gamma values to
a value more in line with the 0.45/2.2 ratio used by other manufacturers.

Dark Magic
Often, LED panels are run at substantially lower brightness than their maximum, such as for
indoor and 'on-camera' applications. This results in an unavoidable reduction in effective bit
depth, which can lead to visible artefacts such as banding and loss of detail, especially in dark
areas of the image. Dark Magic helps to alleviate these issues by processing the video signal
at up to 26 bits per channel (78 bits per pixel) within the receiver card and then increasing
the effective bit depth of the output.
Enabling Dark Magic will typically substantially increase the visual quality of the output when
operating at low brightness, though a small amount of 'fizz' may become visible at very
short viewing distances. Increasing the viewing distance will overcome this, but in some
circumstances it may be preferable to uncheck the Dark Magic checkbox.
The greatest improvements can be seen when running very high brightness panels at a
much lower brightness, adjusted via the Brightness (Nits) control.
Dark Magic is available for all Tessera fixtures, except sub-fixtures and those using older
receiver cards. Project files must be created in software version v1.4 or newer to support
Dark Magic.
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Low End Boost
In the same way that the Gamma control adjusts the midtones of video content, the Low End
Boost control adjusts the brightness of darker video content areas. For the most accurate
reproduction, this control should normally be left at 0%, but in some cases a higher setting
may help to recover detail in dark areas of the content. Care should be taken not to push this
control too far as it may start to reveal limitations in the content such as compression
aftefacts and camera noise that normally would remain hidden.
Low End Boost is available on all Tessera fixtures, but defaults to 0% when creating a new
project for the most accurate reproduction. Project files must be created in software version
v1.4 or newer to support Low End Boost.

Per-fixture and Per-group Colour Override

Figure 8-1. Global Colour Override

It is possible to remove single fixtures or groups of fixtures from the control of the Global
Colour sliders and assign values to them separately. This functionality may be useful if you
wish to maintain one whole screen at a constant brightness when there are fixtures grouped
into separate screens on a processor.
The option to Override Global Colour is found on the Properties tab. To do this first select
the fixture or group you wish to override. If you wish to override a number of fixtures
simultaneously with the same values then first select them and make them into a group.
If the selection is a single panel you have the option to adjust Intensity, Red, Green and Blue
gain sliders for the selection.
If the selection is a group there is also the option to control Brightness, (Colour)
Temperature and Gamma.

- 80 -

Note - Once a selection has been overridden on the Properties tab the
global colour controls will have no effect on it until the Override Global
Colour box is unchecked.

ChromaTune
ChromaTune Tab is only available on the M2 processor allows two advanced colour
correction features.

Colour Replace

Figure 8-2. Colour Replace

Colour Replace allows one colour of an incoming source to be replaced by another. The
Enable check box activates the effect.
From allows the selection of the colour or colour range to change. The colour can either be
selected by using the colour picker by clicking on the colour chip, or if using the processor
rather than the Remote application, clicking on the eye dropper can be used to select the
colour from the incoming source on the canvas.

Figure 8-3. From and To colour chips. Note the eyedropper.
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To allows the selection of colour or colour range that you wish the replace the From colour
with. The colour can be chosen in exactly the same way as From, either by clicking on the
colour chip and selecting a colour from the colour picker or by using the eyedropper tool.
The arrows featured next to the eyedropper tools transfer the colour from the respective
colour chip to the other colour chip. e.g. clicking on the From arrow transfers the colour
from the From colour chip to the To colour chip.

Figure 8-4. Selecting a colour from the colour picker.

Hue Tolerance: Hue Tolerance is the amount of difference from the selected hue that are
going to be changed. Hue Tolerance works using the Hue wheel.
Saturation Tolerance: Saturation Tolerance is the amount of difference in saturation from
the colour that is going to be changed.
Brightness Tolerance: Brightness Tolerance is the amount of difference in brightness from
the colour that is going to be changed.
Softness: Softness determines the 'softness' of the edges of the matte used to determine
the areas effected by the replaced colour and those not.
Apply to Hue, Apply to Saturation, Apply to Brightness These checkboxes apply the
tolerance settings to their respective parameters.
Softness This refers to the amount of softness applied to the edges of the correction matte .
The higher the value the smoother the transition between the area affected by the colour
change and those areas not affected.
View Matte This shows the grayscale correction matte used to show the level of effect that
affects each pixel. White areas show areas affected the most, whilst black areas show areas
that remain unchanged.
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Method Set To Colour directly changes the affected pixels to the To colour. Transform To
Colour transforms affected pixels toward the To colour using HSL interpolation. The amount
of change for affected pixels is dependent on how close the pixels are to the From colour.
Example
A red pepper can be changed into green pepper easily. Here is the original pepper:

Figure 8-5. Original red pepper.

By selecting a red colour from the from the canvas using the eyedropper tool, and a suitable
green from the colour picker:

Figure 8-6. From and To colour chips with red and green colours.

This results in the following:
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Figure 8-7. The resulting image after the From To operation.

To turn the pepper completely green requires a bit of tweaking, in this case increasing the
Hue Tolerance parameter to 25%. This results in a completely green pepper.
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Figure 8-8. The resulting green pepper after increasing the Hue
Tolerance.

It can very helpful when using colour replace to use the View Matte feature. This shows the
areas of the image that will be affected by the colour replace operation.
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Figure 8-9. The View Matte feature.
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14-way Colour Corrector

Figure 8-10. 14-way Colour Corrector

The 14-way Colour Corrector allows one or more of 14 pre-defined colours to be adjusted
without affecting other colours. Hue, saturation and brightness controls are provided for
each of the primary, secondary and tertiary controls. Black and white can be adjusted using
RGB gains.
Adjustments are made by entering a numerical value, or by clicking and dragging left/right to
decrement/increment the value.
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Chapter 9 - Presets
Presets
Presets are a way of storing the settings that you make on the processor so that they can be
recalled quickly and easily. These presets can be made to affect all the panels or a small
selection of them depending on how they are grouped. This information may be brightness,
colour input or perhaps positional information. Video and Colour Presets affect all groups,
Position presets affect the particular Group of fixtures they were recorded for.
The preset buttons can be seen at the bottom of the Main Project Screen.

Figure 9-1. Main Project Screen with record buttons highlighted.

Presets are a powerful tool for recalling parameters and fixture positions. For example, if a
screen is in place for an outdoor festival it may be useful to set different colour and
brightness settings during the day to compensate for changes from day to night-time or
cloudy versus sunny conditions. Storing these changes as presets means they can be
recalled quickly the next day when conditions change again.
Types of information can include:
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l
l

l

Positional information - the placement of Groups of fixtures on the canvas.
Colour information - the colour parameters in the colour tab (global colour) and also
the per panel and per group colour values in the Properties tab.
Video information - the parameters contained in the inputs tab including the selected
input source, the colour and brightness information for each input and the geometry
information (Viewport and Active Area).

Pressing one of the Record Preset buttons opens the Preset Recording view.

Using Masking

Figure 9-2. Preset Recording view

Sometimes it may be desirable to load positional information without changing the colour
information of a group of panels or perhaps change the input source without affecting the
global colour. This can be achieved by using masking.
When you store a preset the three letter icons C, P and V that appear after pressing the
Record button are all lit in blue (default). This indicates that, in this preset state, information
will be stored for all the values of colour, position and video that are currently set for those
panels. If you click on any one of these icons at this point it will be deselected and turn grey.
So it is then possible to store just the colour, position or video settings or a combination of
the three.
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Recording Presets
Before storing a Position preset it is necessary to combine the panels you want to be
controlled into a group (see "Fixture Layout" on page 51).

Note - A group can consist of a single panel.

To record a preset:
1. Set the parameters of colour, position or video that you wish to store as a preset
and select or deselect the masking controls: C, P and V.
2. Click the red preset record button. The tiles of the available groups will appear with
striped diagonal lines.

3. Click on the group or groups you wish to select for the preset. Once the group or
groups are selected the diagonal lines will change to solid colour. Only the group or
groups which are selected will be stored into a Position preset.
4. Click the preset button on which you want the new preset to be stored. The preset
can now be recalled whenever needed by clicking on the preset recall button.
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Editing Presets
To change any parameters of a stored preset, recall the preset by clicking on the preset
recall button, make the alterations and re-record it.
Right-click on a preset recall button to rename or delete it.

Using Presets to Crossfade Between Inputs
Switching inputs can be achieved by creating a Video (V) preset for each input. This is a
feature only available on M-Series processors.
To assign crossfade times to these presets right click on each preset and select properties.
The properties of each preset will now appear in the properties tab and there is an option
here to assign a crossfade time.

Note - The cross fade time does not apply to Colour and Position
parameters or any of the other Video parameters except input selection.

- 91 -

Chapter 10 - Live Control
Introduction
Live Control allows users to control and modify the colour, video and position parameters of
the processor remotely using the industry standard DMX or Art-Net protocols, or using the
Tessera Control application for Windows and Mac OS.
These are parameters which would normally be controlled either by adjusting sliders,
selecting options from drop down menus, or in the case of panel position by dragging icons
in the graphic user interface (GUI) of the processor or its remote software.
Live Control can provide flexible control of the Tessera system, ranging from using a DMX
fader desk controlling a single parameter, to controlling multiple groups across several
processors. Live Control can be used to integrate processors into larger control systems and
provide reactive control to external factors such as adjusting panel brightness in outdoor
environments.
Parameters can be controlled either directly, so their values correspond to a DMX channel(s)
or values can be stored into presets and recalled using Live Control.
The following terms defined below will help us to navigate the systems live control
functions.
Live Control Tab – Located in the tab bar, the Live Control Tab contains the options used to
configure the processor for Live Control.

Figure 10-1. Live Control Tab

Processor Parameter – Is any parameter on the processor that can be controlled with Live
Control.
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Control Profile – A control profile, used for DMX and Art-Net control, contains information
about the parameters and assignable items that can be controlled when using that Control
Profile and maps these to particular channels. A Control Profile is not required when using
the Tessera Control application.

Figure 10-2. Choosing Protocol and Control Profile

Protocol – Denotes the actual Control Protocol which is being used to control the processor.
This can be DMX (via the 5 pin XLR input) , Art-Net (via a network connection), or the Tessera
Control protocol which allows control of multiple processors from the Tessera Control
application.

Configuring the processor for DMX control
1) Connect a source of DMX512 to the opto-isolated XLR 5 pin input.
2) Go to the Live Control tab and select DMX from the Control Protocol drop down menu.
3) Enter a Start Address for the processor (default 001). The Start Address will correspond
with the DMX address of the first parameter in the selected Control Profile.
4) Enable Live Control by checking the Enable in the Live Control Tab or clicking the Live
Control button in the Right Button menu.
If DMX is detected, the Live Control button will light up green to indicate that a source of
Live Control has been detected and that Live Control is enabled.
Note: - M2B and T1 processors are fitted with a DMX I/O card which features an opto-isolated
DMX in and through. The DMX I/O card is located above the Ethernet I/O card.
M2B processors can be identified by a serial number that starts with 002xxx.
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Configuring the processor for Art-Net control
1) Connect an Art-Net source to the Net, Net 1 or Net 2 port on the processor’s back panel
(either directly or via switch).
2) Go to the Live Control tab and select Art-Net from the Control Protocol drop down menu.
3) Ensure that the processor is in an Art-Net compliant IP Address and Subnet. This can be
changed in the Setting – Processor menu. Please see "Live Control" on page 92 for more
details.
4) Enter a Start Address and universe for the processor. The Start Address will correspond
with the DMX address of the first parameter in the selected Control Profile and the universe
will determine which Art-Net universe that the processor will listen to.
5) Enable Live Control by checking the box Enable Controls in the Live Control Tab or clicking
the Live Control button in the Right Button menu.
If the Art-Net is detected, the Live Control button will light up green to indicate that a source
of Live Control has been detected and that Live Control is enabled.

Note - M2B processors are fitted with a pair of control Ethernet ports,
marked Net 1 and Net 2, which share the IP address set in the Settings –
Processor menu. This is helpful when you wish to connect a Remote PC or
laptop to one port (For local control) and still have an Art-Net input to the
processor on the second port. When connecting multiple processors to a
single DMX over Ethernet source it is recommended to manage signal
distribution with switches rather than using the second port as a thru
port. M2B processors can be identified by a serial number that starts with
002xxx.
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Configuring the processor for control from Tessera
Control

Figure 10-3. Control application GUI

1) Download and install the Tessera Control application on a Windows or Mac computer.
2) Run the application and select the relevant Network Interface from the drop-down.
3) Connect the computer to the Net, Net 1 or Net 2 port on the processor’s back panel
(either directly or via switch).
4) Go to the Live Control tab and select Tessera Control from the Control Protocol drop
down menu.
5) Choose a Channel number and set this in both the Tessera Control application and the
Live Control tab. The Channel number is used to determine which processors are controlled
by which instances of the Tessera Control application. By selecting the same Channel
number on multiple processors they can be controlled simultaneously from a single instance
of the Tessera Control application.
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Figure 10-4. Selecting the Tessera control protocol

6) Enable Live Control by checking the box Enable Controls in the Live Control Tab or
clicking the Live Control button in the Right Button menu.
If the computer running Tessera Control is detected, the Live Control button will light up
green to indicate that a source of Live Control has been detected and that Live Control is
enabled.

Enabling Live Control

Figure 10-5. Enable Controls checkbox
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Figure 10-6. Live Control Tab and icon

Live control can be enabled by checking the box marked Enable Controls or by clicking on
the live control icon. The icon will appear blue when Live Control is enabled. Once Live
Control is enabled any parameters included in a selected Control Profile will go to the value
defined by the incoming DMX or Art-Net signal. When Live control is disabled the parameters
will return to the value set by the GUI before DMX was enabled.
The Live Control icon indicates the live control status. This can present in 5 different states.

Figure 10-7. Unconfigured

The grey circle indicates no control profile has been chosen and Live Control is disabled. This
is the default setting for a new Project File.

Figure 10-8. Configured but disabled and not receiving Signal

A Control Protocol has been chosen and the red circle tells us that no data of the selected
protocol is being received. The grey background tells is Live Control is not enabled.
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Figure 10-9. Configured and enabled but not receiving Signal

A control profile has been chosen and Live control is now enabled. No valid control protocol
signal is being received at this point so the faders will default to either the last valid signal
received or the GUI values before Live control was enabled.

Figure 10-10. Configured but disabled and receiving DMX

The system is configured and a valid DMX or Art-Net signal is being received but the
parameters will be responding to the GUI (and not the incoming signal) as Live Control is not
enabled.

Figure 10-11. Configured, enabled and receiving DMX

Live control is configured and enabled and a valid control signal is being received. The
processor parameters included in the selected Live Control Profile will be responding to
DMX.

Parameter Indicators
When Live Control is controlling a parameter it will display a red icon next to its GUI control.
When Live Control is enabled, controlled parameters will display their current value but
cannot be adjusted manually until Live Control is disabled. When a control profile has been
configured but Live Control has not been enabled the circle appears transparent.
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Figure 10-12. Control profile configured with Live Control active

Figure 10-13. Control profile configured and Live Control disabled.

Control Profiles
A selection of Control Profiles that can be used to control various parameters are included in
the processor. Control Profiles are used with DMX and Art-Net modes only. These profiles
are intended to cover the majority of use cases. However where necessary it is possible to
modify and create new Control Profiles to suit a particular application. For details on how to
do this please contact support@bromptontech.com.
The default Control Profiles contained in the v1.4 firmware are:
Colour - (28 Channels total if fully assigned)
1x Global control of Red, Green, Blue and Intensity Gain.
6x Group assignable sets of Red, Green, Blue and Intensity Gain controls.
Groups - (60 Channels total if fully assigned)
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6x Assignable sets of group position, orientation and Red, Green, Blue and Intensity Gain
controls.
Preset Activate (1 Channel)
1x Channel to trigger up to 127 user definable presets.
Input Controls - (30 channels total if fully assigned)
3x Assignable controls of Input Colour management parameters.
Input Controls+ - (36 channels total if fully assigned)
1x Global control of Red, Green, Blue and Intensity Gain.
3x Assignable controls of Input Colour management parameters.
1x Video Mode selection channel.
1x Preset activation channel.
Since some of the sets of parameters that make up these profiles are repeated and some are
common to more than 1 profile it is possible to control all the profiles with 5 suggested DMX
libraries (See section x.xx). For an up to date breakdown of the channel assignments of the
stock profiles and suggested console library files to control them please refer to the latest
DMX Profiles Listing which can be downloaded from the support page of the Brompton web
site:
www.bromptontech.com/support

Assign controls to a Group or Input
Some Control Profiles that contain multiple sets of group or input controls allow users the
ability to assign each set of controls to a single group (of fixtures) or input (DVI or SDI).
This control is in the form of a drop down menu for each set in the Channel column. When a
new profile is selected all user assignable sets will have the legend “No assigned group” or
in the case of input controls “No assigned video input”.

For Fixture Groups
Clicking on this legend will reveal a drop down menu showing all the available fixture groups
that have been created in that project file. Please note if no fixture Groups have been
created the Menu will have only one option “None” but once fixture groups have been
created and or named they will appear below in the order in which they were created.
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Figure 10-14. Configuring Fixtures

Figure 10-15. Configuring Fixture Groups

In the illustration above the example project includes 4 fixture groups that have been
renamed to describe the screens they control. The user can then assign each screen to set of
DMX channels and parameters that are controllable their DMX or Art Net control device.

For Input Control
On M2 processors clicking on the legend will reveal a drop down menu consisting of None
and the three inputs: DVI SDA-A and SDI-B. Using these controls any one input can be
assigned to any particular bank of 10 channels.
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Figure 10-16. Configuring selected input parameters

The illustrations above show the drop down menu that will appear when you click on the
unassigned parameters. The + symbol will expand the selection to show all the parameters
being controlled by that bank of channels.

Minimum and Maximum Values
Minimum and Maximum values are contained within Control Profiles that set the range of
parameter values that can be achieved when controlled with Live Control. This includes
being able to set lower and upper limits.
This is useful in situations where it may be important to limit the lower or higher values of a
parameter. An example would be limiting the Intensity gain of a processor to prevent panels
being set to a brightness level that is undesirable.
When Live Control is used to control a parameter, the parameter will be limited between the
minimum and maximum values, with the DMX channel used to control the parameter being
scaled between the two values.

Default Values
When working with parameters such as group position, it is important to note that the
location and orientation of the assigned group on the canvas when Live Control was
enabled will be treated as its default location. Minimum and maximum values will be applied
from the initial position on the canvas. If Live Control is disabled and the assigned group is
subsequently moved on the canvas and Live Control is re-enabled, the new position of the
assigned group on the canvas will be used as it’s default position and the minimum and
maximum values will be applied from there. This means that stored presets that place the
group in one position on the canvas may now move it to a different position. So for
consistent positioning in live control it is best not to move the position of groups once live
control programming has begun.
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It is possible to lock a single parameter on the processor to a value by setting both the
minimum and maximum value to the value you would like to lock the parameter too. This
would prevent Live Control from changing the value of this channel whilst allowing changes
to be made to other parameters that are part of that Live Control profile.
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Chapter 11 - System Management
Network Load

Figure 11-1. The Network Load bars

The network section of the Systems Tab is a graphical representation of the network load on
each Tessera Protocol output. The greater the network load on an output, the further to the
right the green bar will be. The processor will warn you if an output is becoming too heavily
loaded. If this happens then you should consider moving some fixtures to another output or
decreasing the network bit depth. When there is an Ethernet link the appropriate output
number next to each bar will be highlighted in white, as in the above picture.
For further details on how network load is calculated, see "Output Capacity" on page 28.

Network Bit Depth

Figure 11-2. The Network Bit Depth drop-down menu

Network bit depth refers to the bit depth at which video data is encapsulated and packetised
and sent to connected fixtures. This does not refer to the bit depth at which the front-side
processing occurs at, which is always 12 bit, and does not refer to the bit depth at which
processing occurs in , which always happens at 16 bit.
By default, the network bit depth is 12 bit, but can be altered to 8 bit or 10 bit. Lowering the
network bit depth can allow more panels to be attached to the processor, however this
should used with care. The network bit depth should always be equal or better than the bit
depth of the input source. For example, DVI is 8 bit and SDI is 10 bit. Reducing the bit depth
can reduce the overall visible image quality, depending on the source, and adjustment of
parameters such as RGB gain or brightness and contrast.
The selected network bit depth affects the capacity of each Tessera output port. See
"Output Capacity" on page 28 for more details.
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Genlock Settings

Figure 11-3. Genlock Settings

Internal
The internal setting allows an overall refresh rate for the processor to work at, which can be
23.98, 24, 25, 29.97, 30, 50, 59.94 and 60 fps, irrespective of the frame rate of sources coming
in to the processor. The processor will automatically compensate where the source frame
rate and the internal refresh rate are different

Reference In
The M Series processor can synchronise its system and panel refresh to an external bi-level
or tri-level reference. The processor will automatically compensate for sources that do not
match the refresh rate of the external reference.

Locking to Video Inputs
Tessera processors can lock the processors internal refresh and fixture refresh to the
refresh rate of an incoming source, whether it be on the DVI-I input, or in the case of the M
series processor additionally on either of the two SDI inputs. The processor will automatically
compensate for sources that do not match the refresh rate of the selected source.
The selected genlock frame rate affects the capacity of each Tessera output port. See
"Output Capacity" on page 28 for more details.
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Note - If the frame rate of the incoming video input is different to the
reference, be it internal, another video input or a bi-level or tri-level sync,
then the processor will match the referenced frame rate by either
doubling frames or dropping frames depending on whether the incoming
frame rate is less than or greater than the reference frame rate. There is
no guarantee that every processor will do this at the same time. For
critical synchronisation between two or more processors then the
incoming frame rate should match the referenced frame rate.

Additional Video Delay

Figure 11-4. Additional Video Delay

Additional video delay allows the output refresh to be delayed by up to 5 frames. This allows
Tessera processors to match the latency present in other display systems.

Custom Test Patterns
It is possible to import a bitmap to use as custom test pattern. To use the custom test
pattern select the test pattern button on the main canvas window and select Custom Test
Pattern from the drop down menu. Tessera supports a maximum 8MB file size and supports
.jpg, .PNG, .bmp and TIFF formats at up to 1920 x 1080.

Low Latency Mode
Low Latency Mode bypasses the following of Tessera's front-side processing functions: deinterlacing, scaling (upscaling and downscaling), active area, and frame-rate conversion. This
reduces the overall latency by one frame. Colour functions, such as contrast, brightness and
RGB gain remain unaffected. The input source comes in at it's particular resolution and sync
frequency and is positioned 1:1 in the top left corner of the canvas.
NB the processor does not support interlaced video sources in Low Latency Mode.
S-series processors are always in low latency mode, and non-standard canvas sizes switch
the processor into low latency mode.
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The frame rate of the processor is determined by source frame rate, and what the internal or
external reference might be set to.

Typical Latency
The typical latency of the Tessera processors from input to panel refresh for progressive
sources is as follows:
Fixtures using constant current LED drivers and using generic constant current drivers: 2
frames.
Fixtures using PWM LED drivers: 3 frames.
For interlaced sources the latency is 2 fields for constant current fixtures and 3 fields for
PWM driver fixtures.
When fixtures that use constant current drivers are mixed with PWM fixtures then the
processor adds a frame of latency on to the constant current driver fixtures to match the
latency of the PWM fixtures.

Note - We define latency (video delay) as time between the last cycle of a
source frame appearing on the processor's input, and the first cycle that
an LED on a fixture is lit with that frame.
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S4 Settings

Figure 11-5. S4 Settings Tab

The S4 processor's Settings Tab looks slightly different to that of the M2 or T1, as there are
additional options for configuring the S4's front panel buttons.
The Freeze button can be customised to show a custom test pattern/bitmap instead of it's
Freeze function. To do this, select Test Pattern from the Freeze Button Behaviour drop-down
menu. See "Test Patterns" on page 112 for more information.
The front panel buttons can be disabled by unchecking the Enable Buttons checkbox.
See "Freeze and Blackout" on page 114 for more information about the S4 front-panel
buttons.
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Chapter 12 - Diagnostics and Test
Online Panels
The Online Panels window provides comprehensive information about all fixtures currently
detected on the Tessera Outputs. It can be accessed from the Tools menu.

Exporting Online Panels data
The data in the Online Panels window can be exported by clicking the Export Data button.
The data exported will match that which is currently visible, so the selected filter options,
column hiding and sorting will all apply to the exported data.
Data will be exported in Comma-Separated Values (CSV) format, which can be opened by
many spreadsheet applications such as Microsoft Excel, or in a simple text editor

Device Properties
Device Properties displays the selected fixture's device properties in the Properties Tab.
These include the fixture's MAC address, serial number and firmware version.

Figure 12-1. Device Properties
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Beacon
The Beacon button highlights selected fixtures by using the Identify test pattern which
features a white border with a dark blue on each of the selected fixtures. The status LEDs will
also flash on the back of the selected fixtures.

Figure 12-2. A Beaconed panel showing the Identify internal test
pattern.

Reset
Reset allows the selected fixtures to be reset

Reload Firmware for Selected Panels
This allows firmware to be uploaded for selected fixtures.

Test Pattern
The Test Pattern drop-down menu allows you to select a range of internal test patterns that
are generated on the fixtures themselves. These patterns are particularly useful for testing a
range of fixture and fixture module based issues.
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Figure 12-3. Internal Test Pattern drop-down menu.

On some fixtures it is also possible to trigger these test patterns using a self test button on
the back of the tile (refer to fixture manufacturer documentation for specific functionality).

Selected Calibration
The Selected Calibration drop-down menu allows the selection of different colour calibration
profiles that might be stored in a fixture. The amount of different colour calibrations
available is dependent on how much flash memory available for calibrations on the fixture.
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Figure 12-4. Selecting between the internal calibration and uncalibrated.

Test Patterns
Processor Test Patterns
The Tessera processor has a selection of built-in test patterns. These can be used to verify
the correct performance of the fixtures and also to verify that a finished layout of fixtures are
in the correct arrangement.
Scrolling/moving test patterns will always move exactly one pixel horizontally and/or
vertically per frame (at the genlocked frame rate). Therefore the motion should be perfectly
smooth. Any juddering, double/dropped frames or tearing between fixtures would indicate
issues on the network or within individual fixtures.
To activate test patterns click on the test pattern button in the right hand corner of the
main project window.
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Figure 12-5. Test Pattern button with associated drop-down menu
that allows the selection of the relevant test pattern

To turn off test patterns click on the icon again and it will turn grey.
To change test pattern click on the small white triangle to the right of the icon and it will
give a selection of test patterns as shown in figure X.
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Custom Test Patterns allows custom test pattern bitmaps to be loaded into the processor.
The custom test pattern image can be chosen for each project in the System tab. See
"Custom Test Patterns" on page 106

Fixture Test Patterns
In addition to the processor test patterns it is possible to trigger test patterns on individual
fixtures or groups of fixtures by selecting them in the canvas. See "Device Properties" on
page 109 for more details

Freeze and Blackout
Pressing the freeze button will pause the incoming video signal and hold the final frame
indefinitely. Pressing the freeze button again will resume live video.
Pressing the blackout will cause all panels to go black. Pressing the button again will resume
live video.

S4 front panel buttons
The S4 features 2 buttons on the front panel to control freeze and blackout. By default these
perform the same functions as the buttons in the GUI. The buttons illuminate red when they
are activated.

Figure 12-6. S4 buttons on the front panel

The front panel buttons can be disabled on a per-project basis. The Freeze button can also
be customised to show a custom test pattern/ bitmap instead of it's Freeze function. See "S4
Settings" on page 108 for information on setting these options.
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Chapter 13 - On-Screen Colour Adjustment
On-Screen Colour Adjustment (OSCA)
Tessera processors feature comprehensive fixture-based seam adjustment for fixture and
module seams and 7 way colour correction for modules and panels.
High pixel pitch fixtures require absolute mechanical precision when connecting to adjacent
panels. However, due to mechanical design tolerances many higher pixel pitch fixtures have
issues lining up precisely with adjacent fixtures, or can even have slight mechanical
misalignment issues between the LED modules that make up the fixture. This can give rise to
the appearance of perceived bright or dark lines at the seams of fixtures or modules. This
can be particularly noticeable when viewing certain kinds of content or solid colours, and
appears as bright or dark seams between adjacent panels. One technique to help ameliorate
this is to adjust the luminance of the pixels at fixtures' seams, either on a fixture basis, if
there is an issue between adjacent panels or on a module basis, if there is an issue between
adjacent modules within an LED fixture. OSCA provides the user with an easy and
comprehensive method of quickly resolving difference in seam luminance between a groups
of fixtures and, if necessary, the modules that make up the fixtures.
Occasionally when using different batches of the same LED fixtures together, the LEDs may
have aged differently, or the fixtures may have slightly different calibrations. OSCA allows
comprehensive colour correction to quickly match fixtures which appear to have slightly
different colours or brightnesses.
Note: OSCA is a fixture based adjustment and OSCA values are stored in the fixture. This
means the adjustments travel with the panels themselves, so if a LED wall is re-assembled
from fixtures in a different order, the OSCA adjustments can be used with the new fixture
order. NB OSCA adjustments do not overwrite existing fixture colour calibrations.

Note - OSCA is called on-screen colour correction because when the
processor is in OSCA Mode it uses a special user interface that appears on
fixtures themselves, highlighting selected fixture or module seams,
fixtures or modules making it quick and intuitive to make adjustments on
several fixtures.
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Putting the processor into OSCA Mode can be achieved either the Tools drop-down Menu in
the Main Project Screen, or by using the keyboard shortcut Ctrl+Shift+O.

Figure 13-1. Putting the processor into OSCA Mode via the Tools
menu.

Putting the processor into OSCA Mode will disable the video output.

Figure 13-2. The disable video output warning

OSCA adjustments are performed in the On-Screen Colour Adjustment window.
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Figure 13-3. The On-Screen Colour Adjustment window

The On-Screen Colour Adjustment window displays the fixtures in the project as they are
positioned on the canvas and has a toolbar that is particular to fixture colour and luminance
adjustments.
Fixtures can be selected the same way as on the Project Screen. Layers can be particularly
helpful with selecting panels for OSCA adjustment. Please see "Layers" on page 62 for more
details.
Putting the processor into OSCA mode outputs a solid colour on the connected fixtures. By
default this will be white. However it is possible to display each of the primary colours (red,
green and blue) or secondary colours (cyan, magenta, and yellow).

Display Colour
Changing the colour displayed on the fixtures can help to assess differences in seam
luminance, or colour variances between fixtures. Changing the colour can be done either by
selecting the colour from the OSCA toolbar, using it's keyboard shortcut, or by using Space
or Ctrl-Space to cycle through the different colours.
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Figure 13-4. The Display Colour section of the OSCA toolbar

Display Video
Video can be displayed temporarily in OSCA Mode by pressing the Video icon on the OSCA
toolbar, or by holding the Tab key down. The video displayed will be whatever the processor
was displaying before it was put into OSCA Mode.

Figure 13-5. The Display Video icon on the OSCA toolbar

OSCA works in one of two modes: Seam Adjustment, which allows the luminance adjustment
of fixtures and fixture modules, or Colour Adjustment which allows colour adjustment of
fixtures or fixture modules.

Seam Adjustment
Seam adjustments allow the correction of luminance at the seams at the edges of fixtures or
between adjacent modules within fixtures.
OSCA allows to select fixture or module seams in several different methods. The different
seam selection methods can either be selected by clicking on the relevant seam selection
method in the Seams selection of the OSCA toolbar, or by hitting F1 to F6.
Multiple seams can be selected according to the different selection methods by marquee
selecting the different fixtures or modules or Ctrl-click.

- 118 -

Figure 13-6. Different seam selection methods

When seams are selected on the OSCA canvas view, the relevant seams are highlighted on
the fixtures themselves, together with a cursor, relating to the position of the cursor on the
OSCA canvas.
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Figure 13-7. OSCA on fixtures showing selected seams and cursor

Once the desired seams have been selected then the luminance can be adjusted by clicking
and dragging up or down on the Seam Adjustment Luminance thumbwheel. You can also
hover the mouse pointer over the Luminance thumbwheel and use the scroll wheel on your
mouse.
You can also use the keyboard to control luminance by holding down 1 and using + or - to
increase or decrease the luminance. Holding down Ctrl-1 gives fine control of luminance.
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Figure 13-8. Seam Brightness Correction panel.

The Seam Brightness Control panel features Layer selection. See "Layers" on page 62 for
more information on Layers. Displayed Layers have a tick along side them. To 'hide' layers
then click on the tickbox to untick the box on layers you wish to hide. Hidden layers do not
output OSCA Mode.
There is a Brightness slider and spin-box to allow the overall selected fixture or module
brightness to be adjusted. Toggling fine controls allows the fine control of luminance to be
used in preference to the default course control. This means the Ctrl key does not have to
be held down to use fine mode.
The Reset button under the Luminance thumbwheel allows the original luminance value to
be restored.
The Enable Seam Brightness Correction and Module Colour Correction tickboxes allow these
features to be switched on or off.

Colour Adjustment
Colour Adjustment allows powerful 7 way colour correction of fixtures or fixture modules,
but with a quick and intuitive user interface.
To access Colour Adjustment of fixtures then select the Fixture icon on the OSCA toolbar or
press F8, and to adjust modules select the Modules icon on the OSCA toolbar or press F7
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Figure 13-9. Icons for selecting module or fixture Colour Adjustment on the OSCA toolbar

Selecting Fixture or Module for Colour Adjustment allows colour correction on a fixture
basis or on a module basis. The canvas will allow the selection of fixtures or modules
respectively:

Figure 13-10. The canvas showing module selection mode for Colour Adjustment
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Figure 13-11. The canvas in fixture selection mode for Colour
Adjustment

Modules or fixtures can be selected in the usual manner, depending on whether you have
Module or Fixture Colour Adjustment selected. When the required fixtures or modules have
been selected, the Colour Adjustment panel is displayed. The Colour Adjustment panel is
similar in nature to the Seam Brightness Control panel. By using the different Display Colours
7 way colour correction can be accessed.
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Figure 13-12. The Colour Adjustment panel showing Master Colour
Controls and White Adjustments

The Colour Adjustment panel features Master Colour Controls: Luminance, Red Gain, Green
Gain and Blue Gain. These give an overall level of colour control. In a similar fashion to
adjusting Seam Luminance values, these values can be changed in a few different ways:
moving the mouse pointer over to the required parameter thumbwheel and clicking and
dragging up and down, or clicking and using the scroll wheel, or by using the keyboard
shortcuts. The keyboard shortcuts are displayed above each paramater: 1 allows Luminance
to be adjusted, 2 Red Gain, 3 Green Gain and 4 Blue Gain. These can be used in conjuction
with the - and + keys to decrease and increase values. 1, 2, 3, 4 can be used together
Ctrlfor fine control.
By using the the Display Colour controls Colour Adjustments can be made to white and
primary and secondary colours. NB The controls only adjust the colour of the test pattern
being used.
Selecting White from Display Colours allows Luminance, Red, Green and Blue Gain to be
adjusted for white. These can be adjusted using the mouse and scroll wheel in much the
same way as before. The keyboard shortcuts for adjusting the white Luminance, Red, Green
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and Blue Gain are Q, W, E and R respectively. The value of these can be decreased and
increased by using the - and + keys, and using the Ctrl key together with Q, W, E and R

Figure 13-13. Yellow Adjustments

Selecting red, green, blue, cyan, magenta or yellow from Display Colour allows Hue,
Saturation and Luminance to be adjusted for each respective colour. The Hue, Saturation
and Luminance can be adjusted in much the same way as above. The keyboard shortcuts for
Hue, Saturation and Luminance are Q, W and E respectively.
All these adjustments can be reset back to their defaults by pressing their individual Reset
button.
Hide Selection tick box hides the selection on the fixtures.

Figure 13-14. Confirm or Cancel buttons
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When the seams, fixtures or modules have been colour corrected sufficiently, then selecting
the Green tick above will confirm and store the OSCA settings. Please note this can not be
Undone. Pressing the Cancel button will cancel the OSCA settings. Pressing either the
Confirm or Cancel buttons will return the user to normal operation.

OSCA Keyboard Shortcuts
General OSCA Shortcuts
F1 - F6
F7
F8
A
S
D
F
G
H
J
Tab
Space
Ctrl+Space

Seam selection mode
Module Colour Adjustment
Fixture Colour Adjustment
Display white
Display Red
Display Green
Display Blue
Display Cyan
Display Magenta
Display Yellow
Display Video
Change Display Colour forwards
Change Display Colour backwards

OSCA Colour and Luminace Adjustments
1
2
3
4
Click+Scroll Wheel
+
Ctrl+ parameter shortcut

Luminance Adjustment
Red Gain
Green Gain
Blue Gain
increase/ decrease parameter
Decrease parameter
Increase parameter
Fine Adjustment

White Adjustment
Q
W
E
R

Luminance Adjustment
Red Gain
Green Gain
Blue Gain

- 126 -

Red, Green, Blue, Cyan, Magenta and Yellow Adjustment
Q
W
E

Hue Adjustment
Saturation Adjustment
Luminance Adjustment
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Chapter 14 - Processor Settings
From the Main Project Screen it is possible to set a number of user definable settings for the
processor. In the Main Project Screen choose Settings from the Tools menu.

Figure 14-1. Tools dropdown menu

Processor Settings

Figure 14-2. Processor Settings
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Identification
It is possible to change the name of the processor as it appears when you connect to it
remotely. This can be particularly useful when building a system that uses multiple
processors. If no name is set the processor will be displayed by its serial number in the
Discovered Processors list in Tessera Remote.

Network Settings
The default IP address of a Tessera processors is 192.168.0.50 with subnet mask of
255.255.255.0.
In addition to being able to set the processor to different static addresses and ranges it is
also possible to set processors to receive an IP address from a DHCP server.
The gateway field allows you to add the IP address of a network gateway such as a router.
When using more than one processor on the same network it is recommended to use the
processors on different IP addresses within the same IP range.

Logging
The processor can log its actions in a file which can be viewed from the Tools menu in the
Main Project Screen. This information can be useful when trying to track what was
happening directly before a fault or crash.
It is possible to set the level of detail logged by the processor in this menu ranging from
Critical (lowest) to Debug (highest). A high level of detail may reveal more of what the
processor was doing at a given moment, however it may make it more difficult to find the
salient information.

Syslog
This feature is not implemented yet.

Enable Watchdog
The watchdog is an hardware level process separate from the main processor which
monitors the processor and restarts it if it stops responding, even in the event of a complete
processor crash . With the watchdog disabled the processor will remain in this state until it is
manually rebooted. This may be desirable sometimes when you are trying find the reason for
an issue, but generally it is preferable to have the watchdog enabled. This is the default
setting.
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Security

Figure 14-3. Security settings with no password set- the default
setting.

Figure 14-4. Setting a password

It is possible to set a password for the processor. This password will then be requested from
users connecting to the processor from the Tessera Remote application. The password is
reset if factory settings are restored or it can be removed by re-entering the password in this
window.

Date and Time

Figure 14-5.

It is possible to set the date and time of the processor. To do this click separately on the day,
month and year of the processor so that it becomes highlighted. You may then type in a new
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value or use the up and down arrows to change the values. This information is used in log
files and crash reports.

Fixture Firmware

Figure 14-6. Fixture Firmware screen

This window allows you see which version of fixture firmware is currently set as the preferred
for each type of supported fixture. Typically this will be the firmware version included with
that version of processor software.
Should you wish to set the processor to upload a different version of fixture firmware which
was not included with the release software of the processor it is possible to load newer (and
older) versions of fixture firmware and assign these as the default for a particular fixture.
To do this:
1. Click on the Import... button at the top of the screen. You can now load new firmware from a USB flash drive or from the hard drive of a connected PC if using
Tessera Remote.
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2. Once the firmware is loaded assign that file to be the default by selecting the type
from the list and selecting the firmware version from the dropdown menu at the
bottom of the screen.

Note - This window does not load firmware to any fixtures. It simply sets
the preferred file to be used if you do decide to reload firmware from this
processor. For more information on fixture firmware and the options for
reloading see Reload Fixture Firmware

Preferences

Figure 14-7. Preferences

Auto Load
When the processor is turned on you are taken to the Start Screen, which displays Recent
Projects on the right. The last used project file will appear at the top of this list and, if within
10 seconds no other file is selected or no other option is chosen, the processor will
automatically load this file. If you do not want the processor to do this it is possible to disable
this option so that the processor remains on the Start Screen until an option is selected.
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Note - It is possible to change the autoload countdown time to a value
between 0-3600 seconds. It may be desirable to set this value to zero
before the processor is used on a show, as this will mean that in the event
of a power cut the processor will reboot straight into the current project
file with the minimum of delay.

Status Bar

Figure 14-8. The Status Bar

The status bar is the line of text information in the bottom left corner of the Main Project
Screen. This appears when the cursor is hovered over certain icons or when particular
operations are undertaken. It provides keyboard shortcut information and tips to aid the
user. If you wish to turn this off you can uncheck this option.

Canvas
This section contains settings to help with selecting and aligning fixtures on the canvas.
These features are explained in "Using the Grid" on page 56 and "Fixture Layout" on page 51.

Crash Management
It is possible to set the processor to report crashes. If this option is enabled the processor
will pause after a crash before rebooting to allow time for the user to enter information
about what actions were performed before the crash. The time duration of this pause can be
set between 0 and 3600 seconds. The saved crash reports can then be exported to a USB
flash drive or similar. The crash reporter is to set to on by default.
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Restore factory settings

Figure 14-9. Restore factory settings

Restoring the factory settings will set all user definable characteristics of the processor back
to defaults. This will wipe all project files from the memory of the processor and also any
imported fixture definition files and fixture firmware not included in the current software
release.

Format internal storage

Figure 14-10. Format internal storage

Format internal storage will overwrite the memory of the processor. This will wipe all project
files from the memory of the processor and also any imported fixture definition files and
fixture firmware not included in the current software release. The current software version
of the processor will be retained after an internal storage format has been performed.
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Reload firmware

Figure 14-11. Reload Firmware

The reload firmware option allows the user to change the software which runs the
processor. Any firmware builds which are uploaded to the processor are stored in internal
flash memory and so you may see some older or newer builds under the heading Choose
from existing.
If you do not see the build you wish to use in this menu you can load it from a USB flash drive
or from the hard drive of a remote computer running Tessera Remote. To do this click on
Browse and navigate to the location where the firmware is stored. You can download the
latest processor software from our web site: www.bromptontech.com/support.
Once you have uploaded or chosen the build you wish to use you can reload the firmware.
This is a very quick process after which your project files and additional fixture definition files
should still be available to you. However it is wise to have backup copies of important project
files before a firmware upgrade as a precaution.

Note - Newer firmware versions will almost always allow you to load
project files started on older versions of firmware. Projects started on
newer versions of firmware will not normally work on older versions of
firmware.
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Processor Status

Figure 14-12. Processor status window

The processor status window gives a significant amount of useful information on the current
setup and the condition of the processor. This ranges from details of the current software
and hardware setup to data about the temperature, network settings and revision numbers
of particular components in the processor.
It is possible to export this data to an external USB flash drive or similar by clicking on the
export button at the top of the page. You will then be able to choose the location to save
the file which will have the name “xxxx_state.xml”, where xxxx is the processor serial
number. This can be very useful if you need to contact support and is one of the things which
may be requested.
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About
The About window contains info regarding the end user license agreement between
Brompton and the user. Also included are third party license agreements relevant to the
software, the company address and the support email address:
support@bromptontech.com
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Appendix 1 - Keyboard Shortcuts
Global
Ctrl+Z

Undo

Ctrl+Shift+Z or
Ctrl+Y

Redo

Delete or Backspace
Escape
Ctrl+I
While moving a slider,
hold Alt
F1
F2
F3
F4
F5
F11

Delete selected fixtures or groups
End current task
Show properties for selected fixtures or groups (or for canvas if there is no selection)
Don't snap to default value
Go to Edit mode
Go to Rear Edit mode
Go to Video Only preview (Tessera processor only)
Go to Video And Fixtures preview (Tessera processor only)
Go to Video On Fixtures Only preview (Tessera processor
only)
Fullscreen (Tessera Remote and Offline Editor only)

Canvas
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Ctrl+left-click on a fixture
Double left-click on a fixture
Shift+left-click on a group

Shift+Up/Down/Left/Right
Arrow

Toggles its selection
Select whole string
Select fixture in group
Create duplicates of the selected fixtures
or groups
Select next fixture on string
Select previous fixture on string
Nudge selected fixtures or groups by grid
spacing
Nudge selected fixtures or groups by one
pixel

While adding fixtures, Shift+leftclick

Add a new fixture and join it to the last
added fixture

While adding fixtures, Left-click
and drag

Create an array of fixtures

Ctrl+drag
Tab
Shift+Tab
Up/Down/Left/Right Arrow

While adding fixtures, Alt+wheel
While moving fixtures or an array, hold
Alt

Set angle of new fixture
Invert snapping behaviour

While resizing active area corner, hold
Ctrl

Unlock aspect ratio

While resizing active area, hold Alt
Ctrl++

Invert snapping behaviour
Zoom In

Ctrl+Ctrl+0
Ctrl+wheel
Middle-click and drag
Space+drag

Zoom Out
Zoom 1:1
Zoom in and out
Zoom to the dragged rectangle
Pan the view
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Appendix 2 - Supported Resolutions
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Name
NTSC (480i)
NTSC (16:9)
720x480p
720x480p
(16:9)
PAL (576i)
PAL (16:9)
720x576p
720x576p
(16:9)
640x480
800x600
1024x768
1280x768
1280x800
1280x960
1280x1024
1360x768
1364x768
1364x1024

Horizontal Vertical
Active
Active
720
480
720
480
720
480

Scan Type
Interlaced
Interlaced
Progressive

Supported Frame Supported
Rates
Input/s
59.94Hz
SDI
59.94Hz
SDI
59.94Hz
DVI

720

480

Progressive

59.94Hz

DVI

720
720
720

576
576
576

Interlaced
Interlaced
Progressive

50Hz
50Hz
50Hz

SDI
SDI
DVI

720

576

Progressive

50Hz

DVI

640
800
1024
1280
1280
1280
1280
1360
1364
1364

480
600
768
768
800
960
1024
768
768
1024

Progressive
Progressive
Progressive
Progressive
Progressive
Progressive
Progressive
Progressive
Progressive
Progressive

59.94, 60Hz
50, 59.94, 60Hz
50, 59.94, 60Hz
50, 59.94Hz
50, 59.94, 60Hz
50, 59.94, 60Hz
50, 59.94, 60Hz
60Hz
50, 59.94Hz
50, 59.94Hz

DVI
DVI
DVI
DVI
DVI
DVI
DVI
DVI
DVI
DVI

1366x768
1366x800
1440x900
1440x1050
1536x768
1600x1050

1366
1366
1440
1440
1536
1600

768
800
900
1050
768
1050

Progressive
Progressive
Progressive
Progressive
Progressive
Progressive

DVI
DVI
DVI
DVI
DVI
DVI

1280x720p

1280

720

Progressive

1280x720p

1280

720

Progressive

1920x1080p

1920

1080

Progressive

50, 59.94Hz
50, 59.94, 60Hz
59.94Hz
50, 59.94, 60Hz
50, 59.94Hz
60Hz
23.98, 24, 25,
29.97, 30, 50,
59.94, 60Hz
50, 59.94, 60Hz
23.98, 24, 25,
29.97, 30, 50,
59.94, 60Hz

1920x1080i

1920

1080

Interlaced

50, 59.94, 60Hz

SDI

- 141 -

SDI
DVI
DVI
and
SDI

1920x1080PsF

1920

1080

Progressive
Segmented
Frame
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23.98, 24, 25,
29.97, 30Hz

SDI

Appendix 3 - Setting IP Addresses
Setting the IP address on Windows
1. Click on the start menu and select Control Panel > Network and Internet > Network
Connections. Select the network adapter you are connecting to the Tessera processor with.

2. Select Properties. This will open the network adapter properties.

3. Double click on Internet Protocol Version 4 (TCP/IPv4). This will allow you do set an
IP address.
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4. Click on Use the following IP address to manually enter an IP address. Given that
the default IP address of a Tessera processor is 192.168.0.50/ 255.255.255.0, choose
an IP address that isn’t already taken with in the 192.168.0.x range, where x is a
number between 1 and 254, except for 50.

5. Click OK. Your computer should now be ready to connect to a Tessera processor.

Setting the IP address in Mac OS X
More recent Mac laptops have been shipped from Apple without a wired Ethernet network
interface. To connect to a Tessera processor without using a WLAN requires either a USB –
Gigabit Ethernet adapter or a Thunderbolt – Ethernet Adapter, both of which are available
from third-party suppliers.
1. Click the Apple symbol in the top left corner of the main screen. Select System
Preferences, and click on the Network icon.
2. Open the Configure IPv4 dropdown menu and select Manual from the list of
options.
3. In the IP Address box enter 192.168.0. and a value between 1 and 254 except 50,
and a subnet mask of 255.255.255.0. Then click Apply and your Mac should be ready
to connect to a Tessera Processor.
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Appendix 4 - Warranty
Brompton Technology Limited (”Brompton”) warrants that its Products will be free from
defects in materials and workmanship for a period of two (2) years (”Warranty Period”) from
the original date of purchase and that any spare parts will be free from defects in materials
and workmanship until the end of the Warranty Period or 3 months from the date of which
they have been incorporated into the Product, whichever is the later.
In the event that warranty service is required, please contact Brompton’s support email
address (support@bromptontech.com).

Warranty Conditions
1. Brompton’s obligations are limited to the repair of the defective part or, at its discretion, replacement of the Product or the defective part with a new Product or
part.
2. The warranty is only valid where Brompton has received payment in full for the
Product and the serial number has not been defaced.
3. It is the customer’s obligation to notify Brompton within one week of any suspected defect and to return the Product prepaid to Brompton’s nominated service
address. Product will only be received under warranty when they are returned with
a recognised RMA number that has been issued by Brompton.
4. Warranty repairs must be carried out by a nominated Brompton employee or
Brompton approved agent or service technician. No reimbursement will be made
for repairs carried out by non-Brompton personnel or dealers, and any such repair
work or damage to the product caused by such repair work will not be covered by
this warranty.
5. Product is not considered to be defective in materials or workmanship by reason
that it requires adaptation in order to conform to national or local technical or
safety standards in force in any country other than the one for which the Product
was originally designed or manufactured. This warranty will not cover, and no reimbursement will be made for, such adaptation or any damage which may result.
6. This warranty covers none of the following:
1. Maintenance and repair or replacement of parts due to normal wear and
tear.
2. Cost relating to transport, removal or installation of the Product.
3. Misuse, including the failure to use the Product for its normal purposes or
incorrect installation.
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4. Damage caused by lightning, water, fire, acts of God, war, public disturbances, incorrect mains voltage, improper ventilation or any other
cause beyond the control of Brompton.
7. This warranty is valid for any person who legally acquired possession of the Product
during the warranty period.
8. The customer’s statutory rights in any applicable national legislation arising from
the purchase are not affected by this warranty. The rights under this warranty are
the customer’s sole rights and Brompton shall not be liable for any indirect or consequential loss, damages for any loss of use, time, profits or income, or any damage
to related equipment, materials or consumable parts.
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Index
A
Active Area 67
Adding Fixtures to a Project 42
Additional Video Delay 106
Art-Net Control 94
B
Black Level 70
C
Canvas Modes 57
Edit Mode 57
Reverse Edit Mode 57
Changing Aspect Ratio 69
Changing Topology 47
Colour Adjustment 121
Colour Temperature 78
Connecting To A Processor from Remote 33
Contrast 71
Control Profile 93
Correcting Association 46
Crash Management Settings 133
Creating a New Project 37
Crossfading Inputs 75, 91
Custom Test Patterns 106
D
Date 130
Deleting Projects 42
DMX Control 93
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DVI Input 64
E
Editing Presets 91
F
Fixture Firmware 131
Fixture Layout 51
Fixture Test Patterns 114
Format Internal Storage 134
Freeze and Blackout 114
G
Gamma 78
Genlock 105
Genlock Source 105
Internal 105
Reference In 105
Grid 56
Grouping Fixtures 52
H
HDCP 64
HDMI 64
Histograms 71
Hue 71
I
Identification 129
Importing A Project 41
Input Colour Control 70
Installing Remote Application 30
Installing for Mac OS X 31
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Installing for Windows PC 31
Intensity Gain 77
IP Addresses 143
L
Layer 62
Live Control 92
Logging 129
Low Latency Mode 106
M
Mapping Options 40
1 to 1 Mapping 40
Interpolated Mapping 40
Masking Presets 89
Moving Around The Canvas 55
Moving Fixtures 52
Multiple Processor Control 34
N
Network Load 104
Network Settings 129
O
Offline Editor 34
On-Screen Colour Adjustment (OSCA) 115
Online Panels 109
Opening A Project 41
OSCA Keyboard Shortcuts 126
P
Preferences 132
Auto Load 132
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Canvas Settings 133
Status Bar 133
Presets 88
Processor Settings 128
Processor Status 136
Project Data Export 62
Q
Quick Start Guide 20
R
Recording Presets 90
Reload Firmware 135
Remote Application 30
Remote Network Settings 32
Mac Network Settings 144
PC Network Settings 143
Remote Settings 33
Restore Factory Settings 134
RGB Gain 78
RGB Highlight 71
RGB Shadow 71
Root Nodes 44
Rotating Fixtures 52
S
Saturation 71
Scaling and Cropping 65
Screen Brightness 77
SDI Input 64
Seam Adjustment 118
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Security 130
Selecting Fixtures 51
Selecting Sources 64
Selection Mode 52
Snap To Fixtures 57
Sources 64
Sub-Fixtures 44
Supported Resolutions 140
Swapping Fixtures 46
Syslog 129
System Overview 11
T
Tessera Control 95
Test Patterns 112
Time 130
V
Video On Canvas Modes 59
Fixture Only Mode 59
Video and Fixture Mode 59
Video Only Mode 60
Viewport 65
W
Warranty 146
Watchdog 129
Z
Zoom 69

- 152 -

